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Preface

This tutorial presents the application of the open-source software OpenGeoSys (OGS)
(Kolditz et al. 2012) with a geochemical solver PHREEQC (Palandri and Kharaka
2004) for hydrological simulations concerning reactive transport modeling. This tutorial
is a result of the close cooperation within the OGS community (www.opengeosys.org),
and these voluntary contributions are highly acknowledged.

The book contains general information regarding the reactive transport modeling
and a step-by-step setup of models with OGS and PHREEQC, and related com-
ponents such as GINA_OGS, ParaView, and Data Explorer. Benchmark examples
are presented in detail.

This book is intended primarily for graduate students and applied scientists who
deal with reactive transport modeling. It is also a valuable source of information for
professional geo-scientists wishing to advance their knowledge in numerical
modeling of hydrological processes including reactive transport modeling.

This tutorial is the third in a series that will represent further applications of
computational modeling in hydrological sciences.

• Computational Hydrology I: Groundwater flow modeling, Sachse et al. (2015),
DOI 10.1007/978-3-319-13335-5, http://www.springer.com/de/book/97833191
33348

• Computational Hydrology II: Groundwater quality modeling, Sachse et al.
(2017), DOI 10.1007/978-3-319-52809-0, http://www.springer.com/gp/book/
9783319528083

• Computational Hydrology III: OGS#IPhreeqc coupled reactive transport modeling,
Jang et al. (2017, this volume)

These contributions are related to a similar publication series in the field of
environmental and energy sciences:

• Geoenergy Modeling I: Geothermal Processes in Fractured Porous Media,
Böttcher et al. (2016), DOI 10.1007/978-3-319-31335-1, http://www.springer.
com/de/book/9783319313337

v

http://www.opengeosys.org
http://www.springer.com/gp/


• Geoenergy Modeling II: Shallow Geothermal Systems, Shao et al. (2016),
DOI 10.1007/978-3-319-45057-5, http://www.springer.com/de/book/9783319
450551

• Geoenergy Modeling III: Enhanced Geothermal Systems, Watanabe et al.
(2016), DOI 10.1007/978-3-319-46581-4, http://www.springer.com/de/book/
9783319465791

• Geoenergy Modeling IV: Computational Geotechnics: Storage of Energy
Carriers, Nagel et al. (2017), DOI 10.1007/978-3-319-56962-8, http://www.
springer.com/gp/book/9783319569604

• Geoenergy Modeling V: Models of Thermochemical Heat Storage, Lehmann
et al. (2017*)

• OGS Data Explorer, Rink et al. (2018*),

(*publication time is approximated).

Leipzig, Germany Eunseon Jang
August 2017 Johannes Boog

Wenkui He
Thomas Kalbacher
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Chapter 1
Introduction

Thomas Kalbacher

1.1 Reactive Transport Modeling (RTM)

Reactive transport modeling is an important tool for the analysis of complex inter-
actions between physically and hydro-bio-geo-chemically coupled processes in the
subsurface. It is an effective method of assessing the relative importance and role of
basic processes, which are otherwise treated as isolated, as it provides the opportunity
to describe the interaction of competing processes on different spatial and temporal
scales. Furthermore, RTM provides an important building block for the connection
of scale-encompassing material characterization and is an essential tool for system
analysis from the pore to the field scale.

With the help of RTM, it is possible to simulate the elementary matter fluxes in
soil and deeper subsurface to study the effects of chemical micro-environments,
mechanical-chemical-coupled processes, influences of mineral–liquid reactions,
and/or phase transitions. In general, such models usually deal with a combination of
flow, mass, and heat transport in single-phase and multiphase systems with reaction
pathmodels based on them.However, it should be noted that thesemodels can always
provide only a limited description of the multicomponent reaction network and its
time dependency. The related uncertainties, even if differently large or small, must
never be excluded and should always be discussed detailed.

Multicomponent reactive transport models that treat such a combination of bio-
hydro-geo-chemical processes and transport have already been developed in the
1980s (Aagaard and Helgeson, 1982; Kirkner and Reeves, 1988; Lasaga, 1984;
Lichtner, 1985; Pruess, 1985; Reed, 1982; Yeh and Tripathi, 1989). A very good
overview of all relevant developments of recent decades and current challenges in
the area of RTM can be found in Steefel et al. (2015).

From our point of view, the greatest challenge for the development of realistic
reactive transport (RT)models in the future is perhaps the integration of all spatial and
temporal scales, which are characteristic of the natural process in the subsurface. The
spatial scales can range from the molecular scale through pores and fracture scales to

© The Author(s) 2018
E. Jang et al., OpenGeoSys Tutorial, SpringerBriefs in Earth System Sciences,
https://doi.org/10.1007/978-3-319-67153-6_1
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2 E. Jang et al.

the field-, catchment-, and reservoir scale. In other words, from less than a nanometer
to hundreds of kilometers.

In many real-world applications of RT-models, and especially if several chem-
ical processes are effective, it can be necessary to separate relevant processes and
structures from less relevant ones. Therefore, we have to deal in some way with
the question of physical and chemical heterogeneities additionally. Typically this
requires feeding the deterministic simulations with stochastically generated high-
resolution data sets that contain both physical and chemical heterogeneities on the
basis of geophysical and other field data and assumptions, e.g., Bayer et al. (2015);
Fiori et al. (2011); Jang et al. (2017); Li et al. (2007); Savoy et al. (in press). A com-
prehensive analysis of such systemsmay require ensemble-runs on high-performance
computing (HPC) systems, like a Linux cluster as the use of parallelized RTM codes
can reduce the overall simulation times of larger problems tremendously.

1.2 Reactive Nitrogen in the Environment

This book contains several examples dealing with the problem of nitrogen surplus
in subsurface systems and in particular with denitrification processes. Data-driven
RT-models can support risk assessment and decision-making in order to reduce the
losses of nitrogen from agriculture to the environment and to ensure a sufficient yield
aswell as water protection. Therefore, in this chapter, the role of reactive nitrate in the
environment is to be addressed in general. We deliberately omit chemical equations
since these are explicitly given later in the examples.

Depending on the compound and concentration, nitrogen can be either a vital
nutrient or a pollutant. Nitrogen and its compounds are also very different in the envi-
ronment. While, for example, atmospheric nitrogen is nearly inert, nitrogen oxides
and reduced compounds such as ammonia are reactive.

In the last century, the mankind has massively altered the natural nitrogen cycle,
and the amount of reactive nitrogen in the environment has increased dramatically.
However, the global distribution is very mixed because, in some parts of the world,
the nutrient deficit and the progressive nutrient depletion of soils is a major problem.
For the local population, this means that the agricultural crop yields are decreasing
(Umweltbundesamt, 2014).

In contrast, many industrialized countries release millions of tons of reactive
nitrogen into the environment, which leads to a series of problems such as the loss
of aquatic and terrestrial biodiversity, the increased release of greenhouse gases, and
the complication of the already difficult drinking water production from groundwater
resources. In the recent past, many countries have achieved a significant reduction in
nitrogen emissions from industrialized industry, the energy, transport, andwastewater
sector. In agriculture, the existing directives, regulations, and measures, if any, do
not yet have a lasting and comprehensive effect (Umweltbundesamt, 2014).

In many countries, the most important source of drinking water is groundwater.
Reactive nitrogen from agricultural sources or insufficiently treated wastewater can
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enter the aquifer systems and cause high levels of nitrate concentrations that deteri-
orate groundwater quality. Due to the high concentration of nitrate, water suppliers
may have to give up groundwater resources and have to access new and deeper
groundwater resources. This avoidance strategy leads to additional costs. Even more
worrying is the long residence time of such contaminations because groundwater
moves slow and reacts very slowly to changes. Several years through decades can
pass until these contaminants are detected or reemerge at rivers.

Nitrate is also degraded in the environment, whereby elementary nitrogen and
traces of nitrous oxide are formed. This so-called denitrification can take place in
surface waters, in soil and in the aquifer as well as in sewage treatment plants. The
nitrate decomposition by microorganisms usually occurs under oxygen-free condi-
tions. Organic carbon compounds (heterotrophic reduction) or inorganic compounds
such as iron sulfides (autolithotrophic reduction) are suitable as the necessary reac-
tion partners.

In soil and surface waters, the reaction with organic carbon plays the major role.
By the decomposition of biomass, organic carbon compounds are regularly produced,
but there is rarely a complete degradation, due to other limited reaction conditions
(e.g., oxygen content).

In fully saturated aquifer, the contents of organic carbon are generally low, and
the degradation capacity is thereby limited. It is often much more effective if deni-
trification occurs via oxidation of iron sulfides, but it has to be considered that the
minerals are gradually used up. The degradation capacity is therefore increasingly
exhausted, since a subsequent delivery of these minerals is not possible (Bergmann
et al., 2014; Hansen et al., 2011).

1.3 Coupling of Code and Software

In the field of numerical modeling, the term“coupling” is usually understood as
the linking of different processes or software modules, as well as a measure that
describes the strength of this linkage or the resulting dependency. Only such process
couplings enable us to perform thermo-hydro-mechanical-chemical (THMC)process
modeling in porous and fractured media using simulation programs such as OGS.
The coupling mechanisms of THMC processes using OGS are described by He et al.
(2015); Kalbacher et al. (2012); Kolditz et al. (2012). In this tutorial, we focus on
software coupling of OGS and PHREEQC (Charlton and Parkhurst, 2011; Parkhurst
and Appelo, 2013), which is described more in detail in Chap.2.

The twomain advantages of such a code combinations are obvious. First, new pos-
sibilities arise in model applications. Second, additional synergies can arise through
the intersection of the expertise of entire users and developers groups, which then
may generate new concepts, structures, methods, and procedures.

Frequently, software couplings are realized by formatted files. Data is transported
between applications using simple files. All applications involved must understand

http://dx.doi.org/10.1007/978-3-319-67153-6_2


4 E. Jang et al.

the appropriate format. As file formats, tab-separated or comma-separated, XML-
based or software-specific file formats are often used.

Another and faster possibility is the use of coupling procedures which access
common or shared data structures. In the case of coupling via such procedures, the
client system calls a function on the server with which data structures are generated,
and data are transferred and integrated. At the same time, this makes it possible to
directly start a logic on the server side. In most of such cases, the source code of
one or even both tools must be modified. Different techniques and concepts exist
to make this possible in different programming languages. In the case of OGS and
the PHREEQC, both source codes were written in C++ and thanks to the IPhreeqc
interface (Parkhurst and Appelo, 2013), both software projects could be compiled
together easily.

One of the major challenges for such coupled software systems is their main-
tenance because most of the source code projects develop independently on both
sides. Usually, such developments are not coordinated across groups, and this makes
it difficult couple always the latest releases of both tools.

The individual components of the coupled tools can interact in various ways. In
the case of a one-sided coupling, only one code considers the data flow from one
system to another. In a case of both-sided coupling, both codes consider parameter
changes from the other. In other words, each individual system acts as both a client
and a server. In the case of OGS-PHREEQC, the two tools were both-sided coupled,
and both modify the concentration of the chemical species alternately.

The types of couplings can be also differentiated and arranged by their strengths.
The weaker the coupling, the more independent is the module. A weak coupling of
several software components indicates a small degree of dependency. Code changes
to individual components can, therefore, be made more easily, because a change has
only a local effect. If the tight coupling is given, the code change does not remain local
andmay require additional adjustments in much deeper code and data structures. The
disadvantage of weak couplings is in some cases a lower performance.
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Chapter 2
Methods

Eunseon Jang and Wenkui He

To simulate numerical reactive transport problems, OpenGeoSys(OGS), a scien-
tific open-source software, is coupled to the IPhreeqc module of the geochemi-
cal solver PHREEQC(PQC). This new coupling scheme (hereinafter referred to
as “OGS#IPhreeqc”) is capable of simulating various chemical reactions along-
side different processes such as water flow and solute mass transport. After a brief
description of both codes, OGS (Sect. 2.1) and PQC (Sect. 2.2), the coupling inter-
face OGS#IPhreeqc will be introduced (Sect. 2.3), verified on the basis of an bench-
mark example (Chap.5), and applied to two different reactive transport problems
(Chaps. 6 and 7).

2.1 OpenGeoSys (OGS)

OGS is a scientific open-source initiative based on theGalerkin finite elementmethod
(FEM), and is able to simulate multidimensional THMC (thermo-hydro-mechanical-
chemical) coupled processes in porous and fracturedmedia (Kolditz et al., 2012). This
code has been applied in environmental science, such as in the fields of contaminant
hydrology, water resources management, waste deposition, geothermal systems, and
energy storage. OGS also has been participating several international benchmark-
ing initiatives, such as DECOVALEX (with applications mainly in radioactive waste
repositories), CO2BENCH(CO2 storage and sequestration), HM-Intercomp (cou-
pled hydrosystems), and SeSBENCH (reactive transport processes). A large number
of benchmarks have been developed for the source code and algorithm verification
over the time.

OGS is based on an object-oriented (C++) FEM concept to provide a flexible
numerical framework (Fig. 2.1). It gives various possibilities to simulate a broad
range of different processes which include flow process such as groundwater flow,
overland flow, density-driven flow, unsaturated flow, and two-phase as well as multi-
phase flow processes. Picard and Newton–Raphson schemes can be applied to solve
nonlinear problems such as Richards flow and density-dependent flow processes.

© The Author(s) 2018
E. Jang et al., OpenGeoSys Tutorial, SpringerBriefs in Earth System Sciences,
https://doi.org/10.1007/978-3-319-67153-6_2
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Fig. 2.1 Object-oriented structure of OpenGeoSys Version 5 (Kolditz et al., 2012)

Mass transport in the fluid phase is calculated based on the advection–dispersion
equation (ADE). For the simulation of flow and transport processes, both implicit
and explicit timediscretization schemes canbe applied. To couple different processes,
such as flow, mass, and heat transport, either the monolithic or staggered approach
can be used (Wang et al., 2011).OGS also can handle a randomwalk particle tracking
(RWPT) methods for Euler–Lagrange simulations (Park et al., 2008). To increase the
computational efficiency, the OGS code has been parallelized (Wang et al., 2009).
This helps to deal with computationally intensive tests in the modeling of complex
problems such as the present 3D model of the Nankou area in China (Sun et al.,
2011) and nitrate reduction processes under coupled physical and chemical aquifer
heterogeneity (Jang et al., 2017).

There are two possible ways to simulate reactive transport modeling (RTM) with
OGS. One is to use its internal KinReact modules which is able to simulate kinet-
ically controlled biogeochemical reactions (Ballarini et al., 2014). The other way
is to couple the external geochemical solvers such as OGS-PHREEQC (Xie et al.,
2006; He et al., 2015), OGS-GEMs (Kosakowski and Watanabe, 2014), OGS-BRNS
(Centler et al., 2010), and OGS-ChemApp (Beyer et al., 2012; Li et al., 2014).

More detailed information regarding OGS developments, code resources, and
benchmarks can be found at http://www.opengeosys.org/.

http://www.opengeosys.org/
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2.2 PHREEQC and IPhreeqc Module

PHREEQC is a geochemical solver to simulate a variety of aqueous geochemi-
cal calculations in natural waters or laboratory experiments (Parkhurst and Appelo,
1999). It is freely available and one of the most widely used open-source geo-
chemical solvers in the fields of hydrochemistry and chemical modeling (Lucia and
Kühn, 2013). PHREEQC offers a wide range of equilibrium reactions and kinetic
formulations for modeling nonequilibrium mineral dissolution and precipitation,
microbial reactions, decomposition of organic compounds, and other kinetic reac-
tion (Charlton and Parkhurst, 2011). PHREEQC can simulate batch reaction and
one-dimensional (1D) transport calculations with reversible and irreversible reac-
tions. Inverse modeling for interpretation of different processes is also provided
(Parkhurst and Appelo, 2013). Several databases provide a variety of possibilities
for aqueous speciation calculations, such as Debye–Huckel formations (phreeqc.dat,
wateq4f.dat, llnl.dat, minteq.dat, minteq.v4.dat andiso.dat); the Pitzer specific-ion
interaction model (pitzer.dat) and the specific-ion interaction theory (SIT) model
(sit.dat). All databases include temperature dependence of activity coefficient con-
stants and van’s Hoff or analytical expressions for equilibrium constants (Parkhurst
and Appelo, 1999).

IPhreeqc, where“I” stands for interface, is a C++ PHREEQC module designed
for coupling PHREEQC’s capabilities to other software programs (e.g., multi-
dimensional transport simulators) (Charlton and Parkhurst, 2011). There are several
works to couple IPhreeqc with other codes such as COMSOL Multiphysics (Wiss-
meier andBarry, 2011),OpenGeoSys (He et al., 2015;Kolditz et al., 2012),UTCHEM
(Korrani et al., 2015), and Matlab (Muniruzzaman and Rolle, 2016). The interested
reader is referred to Charlton and Parkhurst (2011) for the detailed information on
IPhreeqc and its data manipulation methods.

2.3 OGS#IPhreeqc Coupling Scheme

In this tutorial, we use the coupling scheme developed by He et al. (2015). The
nonchemical processes such as flow process and mass transport part are simulated
by OGS, and PHREEQC is then applied to handle the local chemical system in each
time step (Fig. 2.2). The coupling scheme is realized at source code level. It means
that IPhreeqc functions can be accessed directly in the coupling interface. This is the
major difference betweenOGS#IPhreeqc and the existing couplingbetweenOGS and
PHREEQC, in whichPHREEQC is executed externally with a system call (Xie et al.,
2006). The Sequential Non-Iterative Approach (SNIA) for Operator Splitting (OS)
is applied for the coupling betweenOGS and IPhreeqc. PHREEQC input data can be
prepared as either a file or a character string in the client program (e.g., OGS). Both
file and character string based approaches are available for data exchange between
OGS and IPhreeqc.
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Fig. 2.2 General concept of the coupling between OpenGeoSys and IPhreeqc (He et al., 2015)

The coupling between OGS#IPhreeqc’s main advantages is listed below.

1. Open-source softwares: Both codes are available free of charge for scientific use.
2. Easy to update: The coupling interface itself is version independent and can stay

unchanged after any updates. For example, a new release version from IPhreeqc
is given, it can be integrated efficiently by updating the source code the IPhreeqc
side. When new IPhreeqc files are added (or old files are removed) in the new
version, only a reconfiguration of the build system is required. This allows user
to benefit continuously from code developments of both sides (He et al., 2015).

3. Capability of simulating a variety of geochemical reactions with dynamic
scale/different processes: Coupled with the geochemical code by utilizing the
IPhreeqcmodule, thus enabling to perform the variety of geochemical reactions
included in the PHREEQC’s reaction package. Moreover, multi-dimensional
scale can be provided by OGS.

4. Computational performance: A significant reduction of the computation time is
achieved by using a parallelization scheme based on the message passing inter-
face (MPI).MPI grouping techniques are applied for the parallelization to enable
a flexible distribution of different amounts of computer resources for the calcu-
lation of two kinds of tasks, i.e., geochemical reactions and the domain decom-
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Fig. 2.3 Parallelization scheme for OGS#IPhreeqc (He et al., 2015)

position (DDC) related processes. As geochemical reaction is solved locally
on each finite element node, its parallelization procedure is independent of the
DDC approach implemented in OGS (Wang et al., 2009), which is applied to
partition the computational tasks of the global assembly and the linear solver
for the calculation of processes such as flow and transport. Figure2.3 represents
the general idea of the parallelization scheme. Two different MPI groups, i.e.,
MPI_Group1 and MPI_Group2, and related intercommunicators are created.
The compute cores which belong to MPI_Group1 will be assigned to calculated
DDC related processes (groundwater flow, mass, and heat transport) as well as
geochemical reactions; whereas those ofMPI_Group2will only take a small part
in the calculation of geochemical simulation. By using this method, optimized
allocation of the number of compute cores for both types of processes can be
realized.

More detailed information about the OGS#IPhreeqc interface and benchmarks
can be found in (He et al., 2015).
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Chapter 3
Software Requirements and Installation

Eunseon Jang and Johannes Boog

Before staring to simulatewithOGS#IPhreeqc, an overview about the single software
component and software installation will be introduced. Figure3.1 summarizes the
main important constituents. The software GINA, GMSH, and OGS Data Explorer
can help to create model geometries and finite elements meshes. ParaView is applied
for visualization and further post-processing steps.

The first step to start the numerical reactive transport modeling is to download and
install all necessary softwares. We use only open access softwares which are easily
available for any user from different web sources. Please download the softwares
individually from the following sources considering your user system (32-Bit or
64-Bit).

1. GINA: To get GINA, which is only free for research and teaching, please contact
Dr. Herbert Kunz (BGR, Hannover, Germany, e-mail: herbert.kuntz@bgr.de) or
the OGS Team (e-mail: info@opengeosys.org).

2. OGS: The latest version of OGS is available here:
https://docs.opengeosys.org/docs/quickstart/basics/quickstart

3. ParaView: ParaView can be downloaded from the website for free here: http://
www.paraview.org/download/

4. Text editor: Any kinds of text editors can be applied. For example, Notepad++
can be found here: https://notepad-plus-plus.org/download/v7.4.2.html

For the application, a step by step description of the model setup will be provided
in the following steps. The model setup covers several steps, and two different RTM
models will be created within the tutorial.

1. Application: Nitrate reduction processes (Chap. 6)

a. Model geometry (GINA)
b. Subsurface meshes (GINA)
c. OGS input files (Text editor)
d. Kinetic geochemical reaction definition (Text editor)
e. Simulation (OGS#IPhreeqc)
f. Results and post-processing (ParaView)

© The Author(s) 2018
E. Jang et al., OpenGeoSys Tutorial, SpringerBriefs in Earth System Sciences,
https://doi.org/10.1007/978-3-319-67153-6_3
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Fig. 3.1 Workflow for
OGS#IPhreeqc

2. Application: Treatment wetlands (Chap.7)

a. Model geometry (Text editor)
b. Subsurface mesh (GMSH, OGS Data Explorer)
c. Simulation conditions (IC, BC, ST etc.) (Text editor)
d. Kinetic biodegradation reaction definition (Text editor)
e. Simulation (OGS#IPhreeqc)
f. Results and post-processing (ParaView)

3.1 Preprocessing I: GINA

The meshing of complex geometrical domains can be done using a pre- and post-
processor GINA developed by the German Federal Institute for Geosciences and
Natural Resources (BGR). GINA is an interactive graphical user interface including
geometry and mesh generation. It provides a preparation of the finite element (FE)—
calculation and visualization of the calculated data.

Geometrical objects (e.g., points, polylines, surfaces, and volumes) can be defined
by using coordinates input and with a mouse click. These geometrical objects can be
used to define initial and boundary conditions and view results. GINA can generate
structured meshes in 1D (line), 2D (quad or triangle) and 3D (prism and hexahedral)
elements. For unstructured meshes in 2D and 3D, an interface to the open-source
software, such as GMSH (described in Sect. 3.2) and TetGen (Si, 2015), is imple-
mented in GINA. With the help of these interfaces, a high-quality mesh of 2D and
3D complex structures can be realized.

http://dx.doi.org/10.1007/978-3-319-67153-6_7
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Table 3.1 Files needed to install GINA

Main program GINA_OGS.exe (version 3.0.9 or higer)

System files comdlg32.ocx

msflxgrd.ocx

richtx32.ocx

comctl32.ocx

mscomctl.ocx

msvbvm60.dll

GINA needs no installation. However, you have to put systemfiles in one directory.
If you use Windows 7 (64 bit), please put the system files (listed in Table3.1) in the
following folder: C:\Windows\SysWOW64\. Then, open a command prompt as
administrator (you can select this option from right-click menu) and run following
command: regsvr32 C:\Windows\SysWOW64\comctl32.ocx.

3.2 Preprocessing II: GMSH and OGS Data Explorer

You can create domain geometries and finite element meshes by using GMSH and
theOpenGeoSys Data Explorer.GMSH is used to create the finite element mesh and
the OGS Data Explorer is employed to convert this mesh into a readable format for
OGS. GMSH is an open-source software tool to develop structured and unstructured
finite element meshes up to 3D for various numerical simulations (Geuzaine and
Remacle 2009). It also includes capabilities of processing numerical simulation and
visualization, however, in this tutorial it will be used as mesh generator only. It can
be downloaded from http://gmsh.info by following the installation instructions on
the web page. Meshing with GMSH is divided in two steps: at 1st you will have to
set up the domain geometry, and 2nd, generate the mesh. Setting up the geometry is
straight forward and can be done in GMSH via point-and-click, or, by writing text
files in an external editor; two additional clicks will create the mesh itself (Fig. 3.2).
Please consider the GMSH help file for further information (http://gmsh.info/doc/
texinfo/).

By default, GMSH mesh files cannot be read by OGS without additional pre-
processing. You have to convert it into a format that is suitable for computations
in OGS by using the OGS Data Explorer. The OGS Data Explorer is the graphi-
cal user interface for OGS and includes functionalities such as data transformation
capabilities for a variety of formats of third party software, manipulation of input
data, visualization of input, and simulation output data. This tutorial will just make
use of the data transformation capabilities to preprocess GMSH mesh files for later
use in OGS. A list of support the file formats of the OGS Data Explorer is listed in
Table3.2.

http://gmsh.info
http://gmsh.info/doc/texinfo/
http://gmsh.info/doc/texinfo/
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Fig. 3.2 Meshing using GMSH and a text editor

Table 3.2 Supported file
formats of OGS Data
Explorer

Data type Formats/ Programs

Raster data GeoTIFF, Esri ACII Raster,
NetCDF, JPEG, etc.

Features Esri Shapes, Petrel borehole
data, GMS borehole data

Meshes FEFLOW, GMS, GMSH,
TetGen, VTK, etc.

Time series data CSV, WaterML

Graphics VTK, OpenSG, Unity,
VRML

3.3 Processing: OGS#IPhreeqc

3.3.1 Download the Source Code

You can download OGS source code from the official OGS-5 repository here: http://
github.com/ufz/ogs5. If you use a Git command line to clone the remote repository
on GitHub to your PC, the source code can be obtained by typing in the com-
mand line prompt. For interested readers, please visit OGS Developer Guide http://
docs.opengeosys.org/docs/devguide5/getting-started/get-the-source-code. Another
approach is to use TortoiseSVN on the Windows platform. TortoiseSVN can help to

http://github.com/ufz/ogs5
http://github.com/ufz/ogs5
http://docs.opengeosys.org/docs/devguide5/getting-started/get-the-source-code
http://docs.opengeosys.org/docs/devguide5/getting-started/get-the-source-code
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Fig. 3.3 SVN dialog with the location of the repository

manage different versions of the source code, and it is also a free software. After
an installation of the TortoiseSVN, the following interface will appear (Fig. 3.3).
You have to provide a Github link (URL of repository) and your folder
(Checkout directory) and then, click OK.

3.3.2 Configure the Building Project

Before the compilation of the source code,CMake has to be applied. It helps to gener-
ate the configuration and makes files which are specific to the building environment.
Here, we are using CMake version 3.5.2 as an example. First, a folder where the
OGS source code is located (source code directory) and a folder where files will be
generated (build directory) have to be assigned (Fig. 3.4).

TheCMake tool runs inside this build directory with a reference to the source code
directory of the project and user-chosen options. After clicking on the Configure
button, you have to choose your desired configuration option by toggling the
corresponding check boxes. Here, for example, we choose the “Visual Studio
2010X86” option. Once the configuration has been done, the build options will
be demonstrated in the CMake Graphical user interface (GUI). It defaults to FEM.
To build the OpenGeoSys code with IPhreeqc, one only needs to choose the IPQC
option (Fig. 3.5). Finally, click the Generate button and then, CMake will prepare
all makefiles in the build folder.
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Fig. 3.4 CMake interface of configuring the build information

3.3.3 Compile the Code

When the configuration is accomplished by CMake, “OGS.sln” file is generated in
the build. Open the file either by double-clicking it in the file browser or opening in
Visual Studio via File →Open →Project. On the project explorer, right-click
on ogs and choose Set as startup project. Then, click BUILD from the
file menu, and then click on the first option Build solution (Fig. 3.6). It takes
a couple of minutes to run the full building process for the first time. When it is
finished, the executable (ogs.exe) will be found under the bin or Debug/Release
folder, depending on which building mode was chosen.
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Fig. 3.5 CMake interface showing different building options

3.4 Post-processing: ParaView

ParaView is an open-source, multi-platform data analysis, and visualization applica-
tion tool.ParaView provides a graphical user interface (Fig. 3.7) to analyze data using
qualitative and quantitative techniques. ParaView builds this functionality on parallel
and distributed VTK (Visualization Tool Kit) file for visualization and data process-
ing. For more general information on ParaView, refer to Ayachit (2015) or Wiki
pages http://paraview.org/Wiki/ParaView. The complete source code and installa-
tion file can be downloaded from the ParaView website: http://www.paraview.org/.
They provide binaries for the major platforms; Linux, Mac OS X, and Windows.

Using OGS, simulation results can be written as VTK files (*.vtk) which can be
visualized with ParaView, OGS Data Explorer, or any other VTK viewer. Addition-
ally, OGS is capable to output Tecplot-files (*.tec) as well.

http://paraview.org/Wiki/ParaView
http://www.paraview.org/


22 E. Jang et al.

Fig. 3.6 Visual Studio interface after opening the OGS solution file

Fig. 3.7 ParaView application windows (from Ayachit 2015)
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Chapter 4
File Description

Eunseon Jang and Thomas Kalbacher

In this chapter, the structure and content of the input files for setting up reactive
transport models are described. First, OGS input file description will be presented
(Sect. 4.1), and then, a short description of the PHREEQC input file will be followed
(Sect. 4.2).

4.1 OGS Input Files

Each of input files is responsible for defining a certain aspect of themodel (Table4.1).
Note that all OGS input files share the same name but with different file ending.

The following is a brief description of each file:

1. PCS—Process definition (*.pcs): This file is used to specify all simulated
processes. The possible processes types are listed at the Chap. A.1
(Appendix A).

2. GLI—Geometry (*.gli): The geometry file contains a description of the ba-
sic geometric objects. The file structure follows a list of ordered points, poly-
gons/polylines, and surfaces. The point, polyline, and surface can be used for
different assignment of physical parameters, such as for initial and boundary
conditions, source term, and output configuration.

3. MSH—Finite element mesh (*.msh): The mesh file contains a geometric and
topological description of a finite element mesh as well as a spatial and element-
relatedmaterial property distribution. Lines, triangles quadrilaterals, tetrahedral,
prisms, and hexahedral elements can be supported. Note that the consecutive
numbering has to be completed without any gaps.

4. NUM—Numerical properties (*.num): The numeric file enables to define and
control the numerical solvers for each simulated process.

5. TIM—Time discretization(*.tim): This file contains a description of time step-
ping schemes for each simulated process.

6. IC—Initial condition (*.ic): In the initial condition file, the values of a primary
variable (such as the concentration of the species, temperature, hydraulic head,

© The Author(s) 2018
E. Jang et al., OpenGeoSys Tutorial, SpringerBriefs in Earth System Sciences,
https://doi.org/10.1007/978-3-319-67153-6_4
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Table 4.1 OGS input files
and descriptions

Input files Explanation

*.pcs Process definition

*.gli Geometry

*.msh Finite element mesh

*.num Numerical properties

*.tim Time discretization

*.ic Initial condition

*.bc Boundary condition

*.st Source/sink term

*.mcp Component properties

*.mfp Fluid properties

*.mmp Medium properties

*.msp Solid properties

*.out Output configuration

and so on) can be specified at a certain location in the model domain at the
starting time of the simulation.

7. BC—Boundary condition(*.bc): The boundary condition file allows defining
boundary conditions by assigning them to geometric objects.

8. ST—Source/Sink term (*.st): The source/sink term defines the distribution and
definition of source and sink terms, as well as Neumann boundary conditions by
assigning them to geometric objects.

9. MFP—Fluid properties (*.mfp): The fluid property file contains a description of
one or more fluids.

10. MMP—Medium properties (*.mmp): This file contains a description of different
porous and fractured media. The properties and parameters are assigned to finite
elements. The spatial distribution of these materials is given in the mesh file
together with the topological description.

11. MSP—Solid properties (*.msp): This file contains additional solid properties
information such as solid density.

12. OUT—Output configuration (*.out): The output file defines how andwhen simu-
lation results are written. Usually, the simulation results are written as VTK files
(*.vtk) which can be later visualized with Paraview, ViSit, OGS-DataExplorer
or any other VTK viewer. Additionally, tecplot files (*.tec) are also supported.

OGS homepage provides more detailed information and additional literature
under https://svn.ufz.de/ogs/wiki/public/doc-auto and http://www.opengeosys.org/
project/publications. Also, anOGS keyword description is presented in theAppendix
A at the end of this book.

https://svn.ufz.de/ogs/wiki/public/doc-auto
http://www.opengeosys.org/project/publications
http://www.opengeosys.org/project/publications
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Table 4.2 Phreeqc input files and descriptions

Input files Description

*.pqc PHREEQC input definition

phreeqc.dat PHREEQC database

4.2 PHREEQC Input Files

To simulate reactive transport modeling coupled with the geochemical code
PHREEQC, an additional PHREEQC input file (*.pqc) and PHREEQC database
(phreeqc.dat) are required (Table4.2). The input file specifies the related geochemi-
cal reactions (such as equilibrium and kinetic reactions) via keywords and associated
data-blocks. The database file contains necessary information (eg., molar mass, sto-
ichiometry, etc.) about chemical elements and substances used in the model compu-
tations. A full description of the keywords can be found in the manual of the program
by Parkhurst and Appelo (1999).

The *.pqc file is based on PHREEQC input file. There are some changes before
running.

1. #comp: At the right-hand side of each component, this command has to be added.
The important thing is that all components have to be defined in the component
properties (*.mcp), as well.

2. #ende: This keyword has to be added after each PHREEQC module (e.g.,
SOLUTION, EQUILIBRIUM_PHAES, RATES, PRINT and so on).

3. There is no need to include the PHREEQC transport module since the transport
processes will be handled by OGS.

By using SOLUTION, we can define the chemical species which will be consid-
ered for the simulation. Note that all mobile and immobile chemical species (also
including pH and pe) have to be defined under SOLUTION or with a special ending
#comp. In the PHREEQC, the concentration of each component is defined with
SOLUTION. In the OGS#IPhreeqc, however, the concentration of component has to
be defined in the initial and boundary condition files (*.ic and *.bc). That means the
concentrations assigned in the *.pqc file does not affect the system. The solution can
be equilibratedwithmineral assembles together in EQUILIBRIUM_PHASES, or the
initial concentration of a component can be adapted when defining the SOLUTION.
Do not forget to add #ende after each PHREEQC module (Listing. 4.1).
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Listing 4.1 Define the SOLUTION and EQUILIBRIUM_PHASES

SOLUTION 1

units mmol/kgw ; default units mmol/kg water

temp 25 ; temperature in degrees Celcius , default = 25C

pH 7 charge #comp 1 ; default pH = 7

pe 4.0 #comp 2 ; pe = -log(electron activity), default = 4

N(5) 3.5E-3 #comp 3 ; nitrogen in the form of nitrate , N(5)

Ca 1.2E-3 #comp 4 ; calcium concentration

[...]

#ende

EQUILIBRIUM_PHASES 1

Gibbsite 0 10 #comp 7 ; Here , SI=0.0 and amount 10 mol

Goethite 0 0 #comp 8

[...]

#ende

For kinetic calculations, the keyword KINETICS and RATES are used. In the
data block RATES, the mathematical expression of the kinetic reactions is defined
via a BASIC interpreter while the parameters controlling the reaction rates set in
the data block KINETIC. Furthermore, KINETICS can define the stoichometrics to
relate the consumption/production of specific substances or elements. For example,
Listing4.2 shows the kinetic rate of organic carbon, and the overall rate reaction is
described as follows:

r = k02
m02

2.94 · 10−4 + mO2
+kNO3

mNO3

1.55 · 10−4 + mNO3
+kSO4

mSO4

1 · 10−4 + mSO4
(4.1)

where k is the reaction rate constant value (molL−1s−1) with kO2 = 7.5E-12, kNO3

= 3.25E-12 and kSO4 = 1.5E-12.

Listing 4.2 Define the KINETIC reactions

KINETICS 1

Organic_C # comp 9

-tol 1e-8 ; tolerance

-m0 5e-3 ; Initial moles of reactant

-m 5e-3 ; Current moles of reactant

#ende

RATES 1

Organic_C ; Name of rate expression

-start

10 if (m <= 0) then goto 200

20 mO2 = mol("O2")

30 mNO3 = tot("N(5)")

40 mSO4 = tot("S(6)")

50 rate_1 = 7.5E-12* mO2 /(2.94E-4 + mO2) + 3.25E-12* mNO3 /(1.55E-4 +

mNO3)

60 rate = rate_1 + 1.5E-12* mSO4 /(1.E-4 + mSO4)

70 moles = rate * m * (m/m0) * time

80 if (moles > m) then moles = m

200 save moles

-end ;Note that the hyphen is required to avoid a conflict with the

keyword END

#ende

END

#STOP
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When -selected_output is set to true, SELECTED_OUTPUT data block
in a subsequent simulation can be applied. By using SELECTED_OUTPUT data
block, you can print selected entities from the composition of solution, exchange
assemblage, pure-phase assemblage, solid solution assemblage, and surface assem-
blage after the completion of each type of calculation. You can control printing of
information to the selected output file using USER_PUNCH. Information defined in
USER_PUNCH will be written to the selected output file. In the Listing4.3, for ex-
ample, SELECTED_OUTPUT block is set to true and the concentration of Na, K
and Cl will be written in the phout_set.dat file.

For the further information, the interested reader can visit the PHREEQC web
page: https://wwwbrr.cr.usgs.gov/projects/GWC_coupled/phreeqc/phreeqc3-html/
phreeqc3.htm.

Listing 4.3 Define output

PRINT

-reset true

-selected_output true

#ende

SELECTED_OUTPUT

-file phout_sel.dat ; file name where selected results are written.

-selected_output true

-user_punch true

#ende

USER_PUNCH

-head Na_mmol K_mmol Cl_mmol

10 PUNCH TOT("Na")*1000, TOT("K")*1000, TOT("Cl")*1000

#ende

#STOP

Reference

D.L. Parkhurst, C.A.J. Appelo, User’s guide to phreeqc (version 2): a computer program for specia-
tion, batch-reaction, one-dimensional transport, and inverse geochemical calculations. Technical
report, U.S. Department of the Interior U.S. Geological Survey, 1999, http://pubs.er.usgs.gov/
publication/wri994259

https://wwwbrr.cr.usgs.gov/projects/GWC_coupled/phreeqc/phreeqc3-html/phreeqc3.htm
https://wwwbrr.cr.usgs.gov/projects/GWC_coupled/phreeqc/phreeqc3-html/phreeqc3.htm
http://pubs.er.usgs.gov/publication/wri994259
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Chapter 5
Code Verification: Engesgaard Benchmark

Wenkui He

The OGS#IPhreeqc coupling interface was tested and verified using several bench-
marks which include degradation of chlorinated hydrocarbons (van Breukelen et al.,
2005), mineral precipitation/dissolution (Engesgaard and Kipp 1992) and uranium
leaching These benchmarks were described in details in He et al., (2015). In this
chapter, the Engesgaard Benchmark (Engesgaard andKipp 1992) is presented, which
simulates the geochemical reactions involvedwhen a solution containingmagnesium
chloride is flushed through a calcite column. Both kinetic and equilibrium reactions
are taken into account in the definition of the geochemical system. The simulation
results obtained by using OGS#IPhreeqc, PHREEQC and OGS-Chemapp (Beyer
et al., 2012) are compared.

5.1 Benchmark Description

A solution containing magnesium chloride (MgCl2) is injected into a calcite col-
umn with a length of 0.5 m (see Fig. 5.1). Calcite dissolves as the solution moves
downstream in the column; whereas temporary precipitation of dolomite occurs at
the calcite dissolution front. This phenomenon can be described by Eq.5.1.

2CaCO3 + MgCl2 ⇐⇒ CaMg(CO3)2 ↓ +CaCl2 (5.1)

The precipitation of calcite is modeled as equilibrium reaction, whereas the dissolu-
tion/precipitation of dolomite is modeled as kinetic reaction using a rate law based
on Lasaga et al., (1994) (see Eq.5.2).

rdolomite = K A(1 − SI (“dolomite”)θ)η (5.2)

where the rdolomite is the reaction rate, K is the overall rate constant, A is the reactive
surface area of dolomite, SI(“dolomite”) is the saturation index of dolomite, θ and η
are empirical exponents.

© The Author(s) 2018
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Fig. 5.1 Schematic
representation of the
Engesgaard benchmark

For this benchmark, the overall rate consists of a base mechanism rate constant
Kneutral and a concentration-dependent contribution from acidmechanism, as shown
in Eq.5.3.

K = Kneutral + Kacidγ
β
H+ (5.3)

where Kacid is the acid mechanism rate constant, γH+ is the activity coefficient of
H+, and β is a empirical exponent.

The rate constants Kneutral and Kacid at a certain temperature other than 25◦C
can be calculated based on Arrhenius equation (see Eq.5.4).

K i = K i
25 exp

(−Ei
a

R

[
1

T
− 1

298.15

])
(5.4)

5.2 Model Setup

A 1D model domain with a length of 0.5m is defined and evenly discretized into
100 line elements. The material properties of the porous medium are summarized
in Table5.1, whereas the initial and boundary conditions (upstream boundary) are
listed in Table5.2. The total simulation time of 21333.32 s is equally discretized into
40 time steps.

The geochemical reactions in the benchmark mainly include the carbonate equi-
librium reactions and kinetically controlled precipitation/dissipation of dolomite.
The thermodynamic data of the default PHREEQC database phreeqc.dat (Parkhurst

Table 5.1 Material properties of the 1D calcite column (from He et al., (2015))

Parameter Value Unit

Effective porosity 0.32 -

Bulk density 1.80 × 103 kg · m−3

Longitudinal dispersivity 6.70 × 10−2 m

Flow rate 3.00 × 10−6 m · s−1

Temperature 298.15 K
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Table 5.2 Initial and boundary conditions for mass transport of the Engesgaard benchmark (from
He et al., (2015))

Species Initial conditions Boundary conditions Unit

Ca2+ 1.23×10−1 1.00×10−7 mol · m−3

Mg2+ 1.00×10−9 1.00 mol · m−3

C(4) 1.23×10−1 1.00×10−7 mol · m−3

Cl− 1.00×10−9 2.00 mol · m−3

pH 9.91 7 –

pe 4 4 –

Calcite 5.7412×10−2 – mol m−3

Dolomite 0.0 – mol m−3

Table 5.3 Definition of the equilibrium reaction system

Reactions Log K values

H2O ↔ OH− + H+ −12.780

CO2−
3 + H+ ↔ HCO−

3 10.329

CO2−
3 + 2H+ ↔ H2CO3 10.329

Ca2+ + CO2−
3 ↔ CaCO3 3.224

Ca2+ + H+ + CO2−
3 ↔ CaHCO+

3 11.435

Mg2+ + CO2−
3 ↔ MgCO3 2.980

Mg2+ + H+ + CO2−
3 ↔ MgHCO+

3 11.399

CaCO3(s) ↔ Ca2+ + CO2−
3 −8.480

Table 5.4 Parameters for dolomite kinetics (from Palandri and Kharaka (2004))

Parameter Value Unit

A 0.001 m2 · kg−1

θ 1.0 -

η 1.0 -

Ea (neutral) 52200 J · mol−1

log(K25) (neutral) −7.53 mol · m2 · s−1

Ea (acid) 36100 J · mol−1

log(K25) (acid) −3.19 mol · m2 · s−1

species (acid) H+ -

β 0.5 -

and Appelo 1999) are applied for the carbonate equilibrium reactions (see Table5.3).
The rate parameters from Palandri and Kharaka (2004) are used for the kinetic rate
law (see Table5.4).
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Fig. 5.2 The concentration distribution of aqueous species and minerals simulated by OGS-
Chemapp, OGS#IPhreeqc, and PHREEQC (He et al., 2015)

5.3 Simulation Results

This benchmark is simulated by using OGS#IPhreeqc, OGS-Chemapp (combined
with theKinReactmodule ofOGS to enable kinetic reactions) and the batch version of
PHREEQC. The PHREEQC script for the simulation is available in the supplemen-
tary material of He et al., (2015). Figure5.2 illustrates the simulated concentration
profiles of different aqueous species andminerals at the end of simulation. Generally,
good agreements are obtained using the three codes.
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Chapter 6
Application: Nitrate Reduction Processes

Eunseon Jang

6.1 Introduction

The coupled reactive transport code (“OGS#IPhreeqc”) is applied to a pyrite-driven
denitrification of nitrate-contaminated groundwater scenario. This nitrate reactive
transport model is a simplification of the model involving both autotrophic and het-
erotrophic denitrification processes based on results from a field study in the Hessian
Ried, Germany (Kludt et al., 2016). For the interested reader, more detail information
can be found in Jang et al., (2017).

After a brief description of the nitrate reduction processes in the groundwater
system (Sect. 6.2), a step-by-step guideline for setting up a 2D RT model will be
introduced.

6.2 Background

Nitrate (NO−
3 ) contamination in groundwater is a widespread water quality problem

and can cause health concerns and environmental impact such as eutrophication
in lakes, reservoirs, and rivers (Fan and Steinberg 1996; Smolders et al., 2010).
Excessive nitrate can be migrated naturally under anaerobic condition by reduction
processes, so-called denitrification, which reduces nitrate to nitrous oxide (N2O)
and dinitrogen (N2) (Korom 1992; Rivett et al., 2008). The nitrate reduction reaction
can be written as a half-equation that describes the role of electron (e−) transfer as
shown in Eq.6.1.

2NO−
3 + 10e− + 12H+ → 2N2 + 6H2O (6.1)

Two important denitrification pathways have been suggested; heterotrophic den-
itrification by oxidation of organic carbon sources and autotrophic denitrification
by oxidation of chemoautotrophic energy sources (e.g., reduced iron, reduced sul-
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fur and methane) (Rivett et al., 2008). Heterotrophic denitrification occurs mainly
in the shallow unsaturated or saturated zones, where organic source is present due
to decaying crop material and leaching from the soil profile (Bailey et al., 2012).
Many studies have been reported that the nitrate reduction by heterotrophic denitri-
fication is thermodynamically favored than reduction coupled to chemoautotrophic
species(autotrophic denitrification) (Korom 1992). However, the latter pathway can
be utilized by denitrifying organisms in the presence of pyrite (FeS2), as well (Tor-
rentó et al., 2010; Zhang et al., 2013). Under anaerobic condition, when electron
acceptors (such as nitrate) are present, pyrite oxidation can be described correspond-
ing to redox reactions.

6.3 Model Components and Governing Equations

6.3.1 Model Scenario

A solution with oxygen, as a primary electron acceptor and nitrate, is entering
from the top boundary at y = 0.5m, representing an oxygenated water source exposed
to the model domain (Fig. 6.1). Since the aquifer’s major reductant pyrite is assumed
to be abundant throughout the model domain, nitrate is reduced to nitrogen by deni-
trification reaction.

In this simulation, the geochemical reactions between the oxidized recharge water
and aquifer’s reductant are kinetically controlled (See Sect. 6.3.3). Neither sorption
nor volatilization is accounted.

The model domain used for the numerical investigation is a 2D cross-sectional
model with 5m length and 0.5m depth. The model domain is discretized with 200
elements. The groundwater flow is simulated by OGS, and a fully saturated steady-
state condition is assumed. The flow direction is from right to left. Two constant
hydraulic head boundaries are assigned to the right and left model boundaries,
imposing a regional hydraulic gradient of 0.001.A mean hydraulic conductivity of
1.55E-4 m · s−1 is assumed. Flow field parameters including bulk density, porosity,

Fig. 6.1 Two-dimensional domain used in the simulation (modified from Jang et al., (2017))
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Table 6.1 Summary of aquifer hydrology, geometry, and transport parameters used for simulation
(modified from Jang et al., (2017))

Parameter Value Unit

Hydraulic conductivity 1.55E-4 m · s−1

Porosity 0.34 -

Column bulk density 1.72E+3 kg · m−3

Time step 30 hours

Reaction time 3000 hours

Number of elements 200 -

and hydraulic conductivity are listed in Table6.1. The simulation runs with a time
step of 30 hours (1.25 days) to the total simulation time of 3000 hours (125 days).

For each time step, flow processes are calculated first, and mass transport using
Advection–Dispersion Equation (ADE) is solved sequentially for each mobile com-
ponent byOGS (see Sect. 6.3.2). AfterOGS calculation is complete, the values of the
each variables on all finite element nodes will be updated, and PHREEQC is applied
to handle local chemical systems.

6.3.2 Groundwater Flow and Solute Transport Equations

Fully saturated groundwater flow based on the water balance and Darcy’s law can
be described by Eq.6.2:

Ss · ∂h

∂t
= ∇ · (K∇h) + q (6.2)

where Ss is the specific storage capacity m−1 of the porous medium, ∇h is the
hydraulic gradient, t is the time sec, K is the hydraulic conductivity m · s−1, and q
is a general source/sink term m · s−1. The velocity of water moving through a flow
field described by Eq.6.3 is shown here:

V = −K∇h

n
(6.3)

where V is the velocity vector (m · s−1) and n is the porosity of the medium (-).
The advection–dispersion equation can be expressed as, e.g., in Bear and Bachmat
(2012) as

∂Ci

∂t
= −∇ · (VCi ) + ∇ · (Di∇Ci )(i = 1, 2, 3, ...,m) (6.4)
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where Ci (mol · L−1) is the molar concentration of the i-th species of the m multi-
species system. Di is the diffusion–dispersion coefficient of component i (m2 · s−1).
The mass transport in the liquid phase can be influenced by convection, diffusion,
decay and biodegradation, sorption and chemical reactions. If we specify the reac-
tion terms in the ADE (Eq.6.4), the coupled set of advection–dispersion–reaction
equations can be written as

∂Ci

∂t
= −∇ · (

V

Ri
Ci ) + ∇ · (

Di

Ri
∇Ci ) + βi

Ri
(i = 1, 2, 3, ...,m) (6.5)

∂Sj

∂t
= β j ( j = 1, 2, 3, ..., n) (6.6)

where Ri is the linear retardation factor of the i-th mobile component (R = 1 +
ρKd/n), ρ is the bulk density (mg · L−1) and Kd is the linear sorption constant (L ·
mg−1)); and βi and β j are the reactions involving mobile and immobile components,
respectively. Sj is the solid phases concentration (mol · kg−1).

Since the sequential non-iterative approach (SNIA) for operator splitting is applied
in the OGS#IPhreeqc coupling scheme, Eq.6.5 is decoupled into a transport step
(Eq.6.7) and reaction steps (Eqs. 6.8 and 6.9) so that transport and reactions are
solved sequentially.

∂Ci

∂t
= −∇ · (

V

Ri
Ci ) + ∇ · (

Di

Ri
∇Ci ) (6.7)

∂C̄i

∂t
= βi

Ri
(6.8)

and
∂Sj

∂t
= β j (6.9)

The advection–dispersion terms for all mobile species (Eq. 6.7) are solved at first
before the resulting concentrations (C̄i ) are used to calculate a set of coupled reaction
terms (both mobile and immobile components, Eqs. 6.8 and 6.9).

6.3.3 Geochemical System

The geochemical reaction system is defined to consider water–mineral interaction
affecting redox reactions (i.e., nitrate reductionprocesses).Related reactions are sum-
marized in Table6.2. The default PHREEQC database“phreeqc.dat”(Parkhurst and
Appelo 1999), which contains the thermodynamic data for aqueous species and min-
eral phases, is used for the simulation. The reactions between the oxidized recharge
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Table 6.2 Definition of the geochemical system (modified from Jang et al., (2017))

Pyrite oxidation and related oxidation of Fe(II)

FeS2 + 3.5O2 + H2O → Fe2 + +2SO2−
4 + 2H+ Pyrite oxidation by oxygen

FeS2 + 14Fe3+ + 8H2O → 15Fe2+ + 2SO2−
4 + 16H+ Pyrite oxidation by Fe3+

FeS2 + 2.8NO−
3 + 0.8H2O → Fe2+ + 2SO2−

4 + 1.4N2 +
0.4H2O

Autotrophic denitrification

Fe2+ + 0.25O2 + H+ → Fe3+ + 0.5H2O and Fe2+ oxidation by oxygen

Fe3+ + 2H2O → FeOOH + 2H+

5Fe2+ + NO−
3 + 7H2O → 5FeOOH + 0.5N2 + 9H+ Fe2+ oxidation by nitrate

Carbonate equilibrium for buffer reaction

CaCO3 ↔ Ca2+ + CO2−
3 Calcite dissolution

CO2−
3 + 2H+ ↔ H2CO3 Carbonate equilibrium I

CO2−
3 + H+ ↔ HCO−

3 Carbonate equilibrium II

H2O ↔ OH− + H+ Dissociation of water

water and the aquifer’s main reductant pyrite are kinetically controlled. Pyrite oxida-
tion using oxygen, nitrate, and sulfate as electron acceptors are assumed to follow a
previously developed and applied rate expression (Williamson and Rimstidt 1994):

rO2 = 10−8.19 · m0.5
O2

m0.11
H+

(6.10)

rO2F e3 = 10−5.78 · m0.92
Fe3+

(1 + mFe2+)0.43
(6.11)

rFe3 = 10−8.84 · m0.28
Fe3+

m0.3
H+(1 + mFe2+)0.52

(6.12)

rNO3 = fni t · m
0.5
NO3

m0.11
H+

(6.13)

rpyri te = Apyrite
m

m0

0.67

pyr
· (1− SI (“Pyrite”)) · (rO2 + rO2F e3 + rFe3 + rNO3) (6.14)

where r is the reaction rate,m refers to the concentration of either O2, Fe2+, Fe3+ or
H+, ( m

m0
)pyri te indicates the change in the surface area of pyrite due to its dissolution,

Apyrite is a pyrite surface area and SI (“Pyrite”) is the Saturation Index of pyrite
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Table 6.3 Required input files for the nitrate RT modeling

File Description

Denitrification.gli Geometry

Denitrification.msh Finite element mesh

Denitrification.pcs Process control

Denitrification.num Numeric file

Denitrification.tim Time discretization

Denitrification.ic Initial condition

Denitrification.bc Boundary condition

Denitrification.mcp Component properties

Denitrification.mfp Fluid properties

Denitrification.mmp Medium properties

Denitrification.msp Solid properties

Denitrification.pqc PHREEQC input definition

Phreeqc.dat PHREEQC database

Denitrification.out Output configuration

mineral,where SI is equal to the logarithmic value of the ratio between the ion activity
product (IAP) and the solubility product (Ksp) for the mineral phases considered.
In the rate equilibrium of Williamson and Rimstidt (1994), fni tm0.5

NO3m
−0.11
H+ was

added for modeling oxidation by nitrate where fni t = 1 similar done by Eckert and
Appelo (2002). The precipitation and dissolution of calcite and goethite is simulated
through the use of mass action equations and the equation describing equilibrium
with LogKsp = −8.48 and LogKsp = −1, respectively.

6.4 Model Setup

6.4.1 Preprocessing

6.4.1.1 Create Geometry

WithGINA version 3.2.1 or higher, we can create the geometry and mesh. First, open
GINA to see the following window (Fig. 6.2).
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Fig. 6.2 Start in GINA

To create the geometry, select the button Geometry(*.gli) and turn on the
Geometry in left navigation. Click the Edit Points to enter point coordinates.
A table will appear where the point number, x-, y-, and z- coordinates, and point
name can be assigned. Please enter seven points as shown in Fig. 6.3- 1© and Listing
6.1. Note that a default unit is the meter (m).

Then, we have to create polylines based on the points. Click Edit Polylines
in the left navigation menu. Lines are an ordered list of the points and also can
be closed to represent polygons by specifying the first and last points of the line
to be identical. An important thing is point numbers in the right field have to be
listed one below the other. Figure6.3- 2© exemplary displays for the polyline named
BOUNDARY. All other points and polylines that have to be entered are summarized
in Table6.4.

A surface is created based on the polyline. Click Edit Surfaces in the left
navigation menu and enter the name of a surface. Then, click a list of polylines and
choose the relevant polyline. In this model, only one surface is needed and therefore,
we create a surface called “AQUIFER” and select “BOUNDARY” for the relevant
polyline (Fig. 6.3- 3©). Finally, Save the created geometry (“denitrification.gli”) by
using File →Save at →Geometry. Now, a geometry file is ready for OGS
simulations (Listing 6.1).
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Fig. 6.3 2D geometry by GINA

Listing 6.1 Geometry file

#POINTS
0 0 0 0 $NAME POINT0
1 5 0 0 $NAME POINT1
2 5 0 0.5 $NAME POINT2
3 0 0 0.5 $NAME POINT3
4 3 0 0.5 $NAME POINT4
5 4 0 0.5 $NAME POINT5

#POLYLINE
$NAME
TOP
$POINTS
2
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3
#POLYLINE
$NAME
BOTTOM
$POINTS
0
1
#POLYLINE
$NAME
RIGHT
$POINTS
1
2
#POLYLINE
$NAME
LEFT
$POINTS
0
3

[...]

#SURFACE
$NAME
AQUIFER
$POLYLINES
BOUNDARY
#STOP

6.4.1.2 Mesh Generation

After the geometry is created, switch the button on Mesh(*.msh). Then, use
the pull-down menu at the top of the window and click Meshing →Creation
Elements from Geometry. Choose the Quad and click Exit (Fig. 6.4- 1©).
You can build line-, tri-, or quad elements from the existing geometry. Make
sure that an option Delete Geometry should be deactivated. Otherwise, your
whole geometrywill be deleted after element creation. Click Meshing →Refine
Elements. Here, you can refine an existing mesh. For this case study, we choose
homogeneous meshing with a relatively small element size of 0.25m (x) and 0.05m
(y). Thus, the x-direction is divided into 20 units (for 0.25m) and the y-direction
into 10 units (for 0.05m) by using Even. The last two steps are Refine and Exit
(Fig. 6.4- 2©). The meshing procedure may take several seconds depending on the
options and your CPU (Fig. 6.5).

Finally, save the mesh file as “denitrification.msh” under File →Save at
→Mesh. Take care that all files (geometry, mesh and any other following ones) have
to be saved in one directory and same name but with different file ending.
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Fig. 6.4 2D mesh generation by GINA

Fig. 6.5 Final 2D model



6 Application: Nitrate Reduction Processes 47

Table 6.4 Assigning names for geometric objects

Polyline Name Point No. Polyline Name Point No.

TOP 2 3 BOTTOM 0 1

RIGHT 1 2 LEFT 0 3

BOUNDARY 0 1 2 3 0 ZONE1 3 4

ZONE2 4 5 ZONE3 2 5

Surface Name Polyline Name

AQUIFER BOUNDARY

Listing 6.2 Mesh file

#FEM_MSH
$PCS_TYPE
GROUNDWATER_FLOW
$NODES
231
0 0 0 0
1 .25 0 0
2 .25 0 .05
[..]
228 5 0 .4
229 5 0 .45
230 5 0 .5
$ELEMENTS
200
0 0 quad 0 1 2 3
1 0 quad 3 2 4 5
2 0 quad 5 4 6 7
[..]
197 0 quad 216 227 228 217
198 0 quad 217 228 229 218
199 0 quad 218 229 230 219
#STOP

6.4.1.3 Process Definition

All processes have to be defined in the process definition (PCS) file. In our simulation,
one water flow (GROUNDWATER_FLOW) and 18 mass transport processes have to be
listed in the PCS file. The number or mass transport processes MASS_TRANSPORT
must have the same number of components which will be defined in MCP file
(Sect. 6.4.1.8). Thus, please add MASS_TRANSPORT PCS block 18 times below
the groundwater flow definition GROUNDWATER_FLOW. Note that the #PROCESS
keyword indicates the beginning of process related numerical setting. Each data block
ends with the beginning of new PCS block with the #PROCESS, or with the file input
terminator #STOP.

Please set up the PCS file by creating “denitrification.pcs” with Notepad++.
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Listing 6.3 Process File

#PROCESS
$PCS_TYPE
GROUNDWATER_FLOW

#PROCESS ; comp 1
$PCS_TYPE
MASS_TRANSPORT

#PROCESS ; comp 2
$PCS_TYPE
MASS_TRANSPORT

[..]

#PROCESS ; comp 18
$PCS_TYPE
MASS_TRANSPORT

#STOP

6.4.1.4 Numerics

The numerical file defines and controls a numerical solver. Since GROUNDWATER_
FLOW and MASS_TRANSPORT processes are used in this simulation, two sets of
numeric data blocks are required. The sub-keywords ELE_MASS_LUMPING and
FEM_FCT help to increase numerical stability of the solution.

Listing 6.4 Numeric File

#NUMERICS
$PCS_TYPE
GROUNDWATER_FLOW
$LINEAR_SOLVER
; method error_tolerance max_iterations theta precond storage
2 6 1.e-014 2000 1.0 1 2

#NUMERICS
$PCS_TYPE
MASS_TRANSPORT
$LINEAR_SOLVER
; method error_tolerance max_iterations theta precond storage
2 6 1.e-014 2000 0.5 1 2
$ELE_MASS_LUMPING
1
$FEM_FCT
1 0
#STOP

6.4.1.5 Time Stepping

Here, we can define the time discretization. A constant time step size of 30 hours
with a total simulation time of 3000 hours is established. Since the default setting
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is SECOND, we need an additional sub-keyword $TIME_UNIT to change the time
unit. The available time unit is SECOND, MINUTE, HOUR, DAY, MONTH, and
YEAR.

Please set up the time stepping by creating a “denitrification.tim” file with
Notepad++. The following code has to be written (Listing 6.5).

Listing 6.5 Time step control file

#TIME_STEPPING
$PCS_TYPE
GROUNDWATER_FLOW
$TIME_STEPS
100 30
$TIME_END
3000
$TIME_START
0.0
$TIME_UNIT
HOUR

#TIME_STEPPING
$PCS_TYPE
MASS_TRANSPORT
$TIME_STEPS
100 30
$TIME_END
3000
$TIME_START
0.0
$TIME_UNIT
HOUR

#STOP

6.4.1.6 Initial Condition

The initial condition file is needed to determine the values of primary variables at
the starting time of the simulation. Open Notepad++ and create a new file called
“denitrification.ic”. Please add the following lines based on the format listed in the
Listing 6.6.

Listing 6.6 Initial condition file

#INITIAL_CONDITION
$PCS_TYPE
GROUNDWATER_FLOW
$PRIMARY_VARIABLE
HEAD
$GEO_TYPE
DOMAIN
$DIS_TYPE
CONSTANT 70

#INITIAL_CONDITION
$PRIMARY_VARIABLE
Na
$GEO_TYPE
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DOMAIN
$DIS_TYPE
CONSTANT 3.67E-04

[..]

$PRIMARY_VARIABLE
Pyrite
$GEO_TYPE
DOMAIN
$DIS_TYPE
CONSTANT 0.0035
#STOP

The primary variables of GROUNDWATER_FLOW and MASS_TRANSPORT are
hydraulic HEAD and solute species (e.g., Na, N(5), and so on) which defined in
the component property file, respectively.

We assume that an initial head of 70m for the entire model domain. Therefore,
the $GEO_TYPE is DOMAIN and the required parameter is CONSTANT 70 at the
GROUNDWATER_FLOW block. The sub-keyword DIS_TYPE specifies the way of
how data are distributed over the defined geometric object. Under DIS_TYPE, first
parameter indicates the distribution type (CONSTANT or CONSTANT_NEUMANN),
and second parameter gives its value. The distribution type CONSTANT assigns
the same value to every node belonging to the given geometric object whereas
CONSTANT_NEUMANN assigns the value multiplied by node area/node length to
each node.

To determine the initial distribution of mobile and immobile species in the model,
MASS_TRANSPORT blocks are required. The initial concentration is based on the
field measurement (Hessian Ried, Germany) conducted by Preiß (2013) and Knipp
(2012) shown in detail in Table6.5. Only one parameter can be defined as a primary
variable per IC block. Thus, total 18 initial data blocks are needed including pe, pH,
and nitrate tracer (chemically inert).

Note that we assume the concentration of nitrate and nitrate tracer are zero before
the simulation. This does not reflect the reality; however, it allows identifying the
distribution of reactive species and calculating nitrate and reaction products over time
without having to consider the past nitrate input and associated chemical reactions.

6.4.1.7 Boundary Condition

The flow direction is from right to left with a regional hydraulic gradient of 0.001.
To do this, we assign the hydraulic head 70.005m at the right model boundary
(POLYLINE_RIGHT). Note that nitrate is entering from the top boundary with var-
ious concentrations of source zones as shown in Fig. 6.1. That means three boundary
condition blocks are needed for the each source zone. Tracer is chemically inert and
used to illustrate the nitrate configuration developing from purely physical transport
in the absence of any reactive processes. Thus, please include three additional bound-
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Table 6.5 Water chemistry and reactants used for initial and boundary condition including
PHREEQC notation (modified from Jang et al., (2017))

Initial condition

pe 5.1

pH 7.8

Aqueous components (mol · L−1)

Na 3.67E-4 Ca 2.54E-3

Mg 8.64E-4 K 4.99E-5

C(+4) as HCO3 4.80E-3 Cl 7.44E-4

S(6) as SO4 9.47E-4 N(5) as NO3 -

O(0) as O2 - Fe(2) as Fe2+ 1.02E-5

Tracer(chemically inert) -

Solid phase (mol · kg−1)

Pyrite (FeS2) 3.50E-3 Goethite (FeOOH) -

Calcite (CaCO3) 5.00E-6 - -

Boundary condition

ZONE1 (·L−1) ZONE2 (mol · L−1) ZONE3 (mol · L−1)

N(5) as NO3 1.45E-3 1.15E-3 6.62E-4

O(0) as O2 2.24E-4 2.24E-4 2.24E-4

Tracer 1.45E-3 1.15E-3 6.62E-4

ary condition blocks for the tracer with the same concentration of nitrate. Oxygen is
assumed to have a uniform distribution with a concentration of 2.24E-4 mol · L−1

Please set up the boundary condition by creating a “denitrification.bc” file with
Notepad++. The following code has to be entered into the file (Listing. 6.7).

Listing 6.7 Boundary condition file

#BOUNDARY_CONDITION
$PCS_TYPE
GROUNDWATER_FLOW
$PRIMARY_VARIABLE
HEAD
$GEO_TYPE
POLYLINE RIGHT
$DIS_TYPE
CONSTANT 70.005

#BOUNDARY_CONDITION
$PCS_TYPE
GROUNDWATER_FLOW
$PRIMARY_VARIABLE
HEAD
$GEO_TYPE
POLYLINE LEFT
$DIS_TYPE
CONSTANT 70

#BOUNDARY_CONDITION
$PCS_TYPE
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MASS_TRANSPORT
$PRIMARY_VARIABLE
N(5)
$GEO_TYPE
POLYLINE ZONE1
$DIS_TYPE
CONSTANT 1.45E-3

#BOUNDARY_CONDITION
$PCS_TYPE
MASS_TRANSPORT
$PRIMARY_VARIABLE
N(5)
$GEO_TYPE
POLYLINE ZONE2
$DIS_TYPE
CONSTANT 1.15E-3

#BOUNDARY_CONDITION
$PCS_TYPE
MASS_TRANSPORT
$PRIMARY_VARIABLE
N(5)
$GEO_TYPE
POLYLINE ZONE3
$DIS_TYPE
CONSTANT 6.62E-4

[...]

#BOUNDARY_CONDITION
$PCS_TYPE
MASS_TRANSPORT
$PRIMARY_VARIABLE
O(0)
$GEO_TYPE
POLYLINE TOP
$DIS_TYPE
CONSTANT 2.24E-4
#STOP

6.4.1.8 Component Properties Definition

For each species, a data block has to be added in a “denitrification.mcp” file.
PHREEQC notation for chemical formulae can be found in Table6.6. Five immobile
components should be defined as immobile ($MOBILE = 0) whereas other mobile
components are transport in the aqueous phase ($MOBILE = 1). For the molecular
diffusion, a value of 1E-9 m2 · s−1 is assumed for the each component.

Listing 6.8 Component properties file

#COMPONENT_PROPERTIES
$NAME
N(5)
$MOBILE
1 ; MOBILE -Flag: 0=imMOBILEe , 1= MOBILEe/transported
$DIFFUSION
1 1E-9 ; diffusion model type , diffusion

constant
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#COMPONENT_PROPERTIES
$NAME
N(0)
$MOBILE
1 ; MOBILE -Flag: 0=imMOBILEe , 1= MOBILEe/transported
$DIFFUSION
1 1E-9 ; diffusion model type , diffusion

constant

[..]

#COMPONENT_PROPERTIES
$NAME
Pyrite ;
$MOBILE
0 ; MOBILE -Flag: 0=imMOBILEe , 1= MOBILEe/transported
$DIFFUSION
0 ; diffusion model type , diffusion constant
#STOP

Table 6.6 Mobile and immobile components

PHREEQC notation

Mobile components

Na Na+

Ca Ca+2

Mg Mg+2

K K+

Fe(2) Fe+2

Fe(3) Fe+3

C(+4) HCO−2
3

Cl Cl−

S(6) SO−2
4

N(5) NO−
3

N(0) N2

O(0) O2

Tracer Nitrate tracer

Immobile components

pe

pH

Pyrite FeS2
Goethite FeOOH

Calcite CaCO3
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6.4.1.9 Porous Media and Material Properties

In this simulation, we assume that the whole domain is one material group. The
material parameters required for the simulation can be defined in the file “denitrifica-
tion.mmp” (Listing 6.9). For the porosity and tortuosity, values of 0.34 and 1, respec-
tively are assumed.Note that for groundwater flowprocesses (GROUNDWATER_FLOW),
the hydraulic conductivity in m · s−1 is used instead of the permeability but the key-
word says $PERMEABILITY_TENSOR. Our model assumes an isotropic case with
a hydraulic conductivity of 1.55E-4 m · s−1. And longitudinal dispersivity (αl) and
transversal dispersivity (αt ) are 0.1 and 0.01m, respectively.

Listing 6.9 Medium properties File

#MEDIUM_PROPERTIES
$NAME
Aquifer
$GEOMETRY_DIMENSION
2
$GEOMETRY_AREA
1.000000e+000
$POROSITY
1 0.34
$VOL_MAT
1 0.66
$TORTUOSITY
1 1.000000e+000
$PERMEABILITY_TENSOR
ISOTROPIC 1.55E-4
$MASS_DISPERSION
1 0.1 0.01
$DENSITY
1 1716.0
#STOP

For the mass transport simulation, the material density of the aquifer and fluid
information are also required. The fluid properties file contains the description of
one or more fluids. The unit of density and viscosity are kg ·m−3 and kg ·m−1 · s−1,
respectively.

Please create “denitrification.msp” and “denitrification.mfp” files and add the
following lines shown in the Listing 6.10 and 6.11, respectively.

Listing 6.10 Solid properties

#SOLID_PROPERTIES
$DENSITY
1 1.716E+003
#STOP

Listing 6.11 Fluid properties

#FLUID_PROPERTIES
$FLUID_TYPE
LIQUID
$PCS_TYPE
HEAD
$DENSITY
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1 1000.0
$VISCOSITY
1 1.0e-3
#STOP

6.4.1.10 PHREEQC Calculation

In the OGS#IPhreeqc simulation, PHREEQC input definition file is based on the
PHREEQC input file. The concentration of each component does not affect the
system. Instead, the real concentration of the component has to be defined in the
initial condition (denitrification.ic) and boundary condition file (denitrification.bc).
Note that the nitrate tracer is not listed in the PHREEQC input file since it does not
include any reactive processes.

Please set up the PHREEQC input file by creating a “denitrification.pqc” file with
Notepad++. The following code has to be entered into the file.

Listing 6.12 PHREEQC input definition

SOLUTION 1
units mol/kgw
temp 25.000000
pH 7.8 charge # comp 1
pe 5.1 # comp 2
Na 3.67E-4 # comp 3
Ca 2.54E-3 # comp 4
Mg 8.64E-4 # comp 5
K 4.99E-5 # comp 6
C(+4) 4.80E-3 # comp 7
Cl 7.44E-4 # comp 8
S(6) 9.47E-4 # comp 9
N(5) 0 # comp 10
N(0) 0 # comp 11
O(0) 0 # comp 12
Fe(2) 1.02E-5 # comp 13
Fe(3) 0 # comp 14
#ende

EQUILIBRIUM_PHASES 1
Calcite 0 5.00E-5 # comp 15
Goethite 0 0 # comp 16
#ende

KINETICS
Pyrite # comp 17
-formula FeS2 1
-m 3.50E-3
-m0 3.50E-3
-tol 1e-008
#ende

RATES
Pyrite
-start
1 A = 15e3*m0
10 if SI(" Pyrite ") >0 then goto 100
20 fH = MOL("H+")
30 fFe2 = (1 + TOT("Fe(2)"))
40 if MOL("O2") < 1e-6 then goto 80
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50 rO2 = 10^ -8.19* MOL("O2")^0.5* fH^-0.11
60 rO2_Fe3 =10^ -5.78 *TOT("Fe(3)") ^0.92* fFe2 ^ -0.43
70 goto 90
80 rem mol/dm3/s
81 rFe3= 10^ -8.84* TOT("Fe(3)") ^0.28* fFe2 ^ -0.52*fH^-0.3
82 rNO3 = TOT("N(5)")^0.5 *fH^ -0.11
90 rate = A* (m/m0)^0.67 *(rO2 + rO2_Fe3 + rFe3+ rNO3) * (1-

SR(" Pyrite "))
100 Save rate*time
-end
#ende

USER_PUNCH
10 PUNCH TOT("N(5)"), TOT("N(0)"), TOT("Fe(2)"), TOT("Fe(3)")

, TOT("O(0)"), TOT("S(6)")
20 PUNCH -LA("H+"), -LA("e-")
30 PUNCH KIN(" Pyrite"), EQUI(" Goethite "), EQUI(" Calcite ")
#ende
END
#STOP

Kinetic rate expressions of geochemical reactions can be calculated with the
embeddedBASIC interpreter inPHREEQC. In the data block RATES, themathemat-
ical expression of the kinetic reactions is defined (described detailed in Sect. 6.3.3).
Do not forget to add #comp at the right-hand side of each component and #ende
after each PHREEQC module.

6.4.1.11 Output

In the output file, we can define how and when simulation results are written. As
shown in the following Listing 6.13, two output blocks are required. Each of them
starts with the keyword #OUTPUT.

For the groundwater flow simulation, wewant to get hydraulicHEAD [m] over the
entire domain with the VTK format. Under the keyword TIM_TYPE, specification
STEPS 10 means that the simulation results will be printed once in every ten steps.
This output block ends with the beginning of the next output block, i.e., #OUTPUT.
In the second output block, the concentration of the transport parameters can be
defined by adding the corresponding names in the sub-keyword $NOD_VALUES.
The parameter should be listed one below the other. Again, the results will be printed
once in every ten steps. The output file ends with the file input terminator #STOP.

Please open Notepad++ and opens a new form and add the following lines. Sub-
sequently, save the file as “denitrification.out”

Listing 6.13 Output File

#OUTPUT
$PCS_TYPE
GROUNDWATER_FLOW
$GEO_TYPE
DOMAIN
$ELE_VALUES
HEAD
$DAT_TYPE
VTK



6 Application: Nitrate Reduction Processes 57

$TIM_TYPE
STEPS 10

#OUTPUT
$PCS_TYPE
MASS_TRANSPORT
$NOD_VALUES
N(5)
N(0)
[..]
Tracer
$GEO_TYPE
DOMAIN
$DAT_TYPE
VTK
$TIM_TYPE
STEPS 10
#STOP

6.4.2 Model Execution

When all input files (Table6.3) are ready, please add the executable ogs.exe to the
folder containing the inputfiles.Open the executable and enter denitrification
in the command line (Fig. 6.6). The simulation starts and results files
will appear (denitrification_GROUNDWATER_FLOW00*.vtk and
denitrification_MASS_TRANSPORT00*.vtk) in your data folder.

Fig. 6.6 Command window of the OpenGeoSys executable
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Fig. 6.7 Open the file in ParaView

Fig. 6.8 Visualization of the mass transport
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6.4.3 Post-processing

For the visualization of simulation result, ParaView can be applied. Open the Par-
aView and click on File →Open in the Main Toolbar. Locate the OGS project
folder and open the file *.vtk which will appear in the pipeline browser. Click on
the data set and press Apply in the properties window (Fig. 6.7). The model domain
should appear in the layout window.

To visualize the mass transport, for example, select “denitrification_
MASS_TRANSPORT..vtk”. Then, you can choose components to visualize in the
pipeline browser Fig. 6.8(1). After you have selected the component, click Rescale
Fig. 6.8(2).

6.5 Simulation Results

Simulation results are shown in Figs. 6.9 and 6.10. Within the upper part of the
aquifer, a sharp boundary is observed where high nitrate transitions into low-nitrate
water. As the oxygen in the solution is quickly consumed with depth, conditions
become thermodynamically favorable for denitrifying NO3 to N2 where the presence
of pyrite is ubiquitous throughout the domain. The depth where nitrate is depleted
coincides with the depth where the concentration of sediment pyrite starts to increase
(Figs. 6.9-a and 6.10-c). Excess nitrogen is comparatively a conservative product
of nitrate reduction and has been used as a natural tracer to identify or quantify
denitrification, especially in deep, confined groundwater system. In this simulation,
it is assumed that the initial groundwater system does not contain any free nitrogen
species. Thus, the amount of nitrogen gas (N2) produced can be referred in terms of
equivalent reduced nitrate by denitrification (Fig. 6.9-b).

Fig. 6.9 Simulation results : Spatial distribution of (a) NO3, (b) N2,(c) O2, and (d) SO4 at the
end of the simulation
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(a) (b)

(c) (d)

Fig. 6.10 Simulation results : (a) groundwater flow, spatial distribution of (b) tracer, (c) pyrite,
and (d) goethite at the end of the simulation

As nitrate is reduced by pyrite oxidation reaction, sulfate (SO2+
4 ) and ferrous ion

(Fe2+) concentration are increased, and the produced ferrous ion is oxidized to ferric
ion (Fe3+). Then, ferric ion is precipitated as ferric oxide or oxyhydroxide such as
goethite (Fig. 6.10-d). The nitrate tracer shows the nitrate configuration developing
from purely physical transport in the absence of reactive processes. The simulated
conservative nitrate tracer mainly reflects the groundwater flow and changes in the
nitrate contents of recharge (Fig. 6.10-b).
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Chapter 7
Application: Treatment Wetlands

Johannes Boog

7.1 Introduction

This chapter describes the implementation of a 2D steady-state reactive transport
model (RTM) of a treatment wetland. Treatment wetlands are technologies used
for handling wastewater and other types of contaminated water. The focus of this
tutorial will be onmodeling secondary treatment of domestic wastewater by a passive
horizontal subsurface flow (HSSF) treatmentwetland. This translates into amodeling
problem of variably saturated flow, transport of particulates and solutes, as well as,
biological degradation of organic carbon, nitrogen, and sulfur. The treatment wetland
that will be simulated was part of an experiment by García et al., (2005) and already
in the focus of modeling studies by Llorens et al., (2011), Langergraber and Simunek
(2012).

In this tutorial, we will show how to implement and execute an RTM with a
coupling of OGS#IPhreeqc step by step.

7.2 Background

Untreated and non-adequately treated wastewater is still a major threat to human
health, environmental safeguarding and the protection of freshwater resources, espe-
cially because of the discharge of reactive nitrogen (WWAP 2017). Treatment wet-
lands have been proven as promising technologies for treating wastewater of various

© The Author(s) 2018
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origins such as domestic and municipal effluents, industrial wastewater (Kadlec and
Wallace 2009; Wu et al., 2015), agricultural runoff (Vymazal and Brezinova 2015),
as well as, contaminated groundwater (van Afferden et al., 2011). Treatment wet-
lands can be characterized asman-made biogeochemical reaction systems thatmimic
natural processes to treat wastewater in an ecological and sustainable manner. The
main treatment wetland type for handling domestic wastewater in temperate climates
is subsurface flow (SSF) systems (Vymazal 2010) (Fig. 7.1).

SSF, especially when intensified with active aeration, combine high treatment
performance regarding wastewater key pollutants such as organic carbon and nitro-
gen with process robustness, low maintenance costs, and a minimum requirement
of infrastructure. Therefore, SSF are suitable to be used in decentralized or semi-
centralized sanitation concepts. To support further optimization and deepen the
process knowledge of SSF wetlands, process-based numerical modeling is a promis-
ing tool (Langergraber 2011). However, only a few process-based numerical models
for wetlands that cover a different range of processes are available (Langergraber
2017). Unfortunately, the most advanced models such as BIO_PORE (Samso and
Garcia 2013a), CWM1 (Langergraber et al., 2009), and CWM2 (Langergraber and
Simunek 2005) are implemented in closed-source codes of commercially available
software.

Subsurface flow constructed treatment wetlands are a complex interplay of the
solid matrix, water flow, microbial organism, and plants (Fig. 7.1). The main drivers
of the treatment processes are microbes and plants. The ratio of their contribution
strongly depends on the inflow water quality and loading rate (influx). In highly
loaded systems, such as horizontal subsurface flow (HSSF) wetlands for secondary
treatment of domestic wastewater, the effect of plants is considered of minor impor-
tancewith respect to the removal of bulk organic carbon and nitrogen. In such context,
biodegradation is the dominating treatment processes.

Biodegradation in passive (no intensification) HSSF wetlands is mainly charac-
terized by anoxic and anaerobe, and to some extent, aerobe processes (García et al.,
2010). The reasons are saturated conditions in the wetland body, low oxygen transfer
rates, and a low content of dissolved oxygen in the inflowing wastewater. In this case,
the dominant chemical species are reduced forms of organic carbon, nitrogen, and
sulfur. With respect to biodegradation, we will focus on simulating the transforma-
tion of organic carbon, nitrogen, and sulfur only. The effect of plants will not be
taken into consideration.
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Fig. 7.1 Schematic of a horizontal subsurface flow treatment wetland according to Nivala et al.,
(2013)

7.3 Model Components and Governing Equations

7.3.1 Experimental System

The treatment wetland to model measures 10.3m in length, 5.3m in width, and 0.6m
in depthwith an averagewater level at 0.5m.Gravel (d10 = 60mm)with a porosity of
0.41 was used as main media. The system was loaded with primary settled domestic
sewage at a rate of 36mmd−1 and planted with Phragmites Australis.

7.3.2 Water Flow and Mass Transport

Water flow in variable saturated porous media can be modeled using the Richard’s
Equation in its pressure based form (from Kolditz et al., 2012b):

ερw

∂S

∂pc

∂pc
∂t

+ ε∇Sq = Qw (7.1)

Here, ε is the porosity, ρw the water density, S denotes the dimensionless water
saturation, pc the capillary pressure and pw the water pressure, t the time, q is the
Darcy flux term, and Qw is a source–sink term. The Darcy term is computed as:

q = ρw

krelk

μw

(∇ pw − ρwg) (7.2)

with, k the intrinsic permeability, krel the relative permeability,μw thewater viscosity,
and g the gravity acceleration. The relationship between capillary pressure and water
saturation is described using the van Genuchten parametrization:

pc = ρwg

α

[
S

− 1
m

e f f − 1
] 1

n

(7.3)



66 E. Jang et al.

were, α is a parameter related to the air entry pressure, n is the pore size distribution
index, m = 1 − (

1
n

)
and Sef f is the effective saturation. The relationship between

krel and Se f f is described as:

krel = S
1
2
e f f

[
1 −

(
1 − S

1
m
e f f

)m
]2

(7.4)

The effective saturation is computed as:

Sef f = S − Sres
Smax − Sres

(7.5)

Hereby, Smax and Sres are the maximum and residual saturation. Mass transport of
a mobile component i is computed using the advection–dispersion equation (ADE)
(Bear and Bachmat, 1990) :

ε
∂SCi

∂t
= ε∇S

(
qCi + D∇Ci + D∗∇Ci

) + Qi + ri (7.6)

where Ci is the concentration of the i-th mobile component, q is the Darcy flux
term, D is the mechanic dispersion coefficient, D∗ is the diffusion coefficient, Qi is
a source–sink term, and ri is the reaction term of the i-th component. As diffusion
is not considered in this model, the diffusion term D∗∇Ci can be neglected for all
components. For an immobile component k such as bacteria, the right-hand side of the
ADE reduces to the reaction term rk . Following the sequential non-iterative (SNIA)
coupling scheme of OGS#IPhreeqc, the reaction term ri in the ADE is decoupled
from solving the transport parts of the ADE. Transport and reaction steps are then
solved subsequently always starting with the transport step.

7.3.3 Biodegradation

This tutorial uses the biokinetic model CWM1 that has already been implemented
in other codes to model biodegradation in HSSF wetlands (Llorens et al., 2011;
Langergraber and Simunek 2012; Samso and Garcia 2013a). CWM1 is described in
detail in Langergraber et al., (2009). Basically, it models the fate of dissolved oxygen,
organic carbon, organic nitrogen, ammonia and oxidized nitrogen, dihydrogen sulfide
and sulfate, as well as hydrolysis of particulate organic matter and the growth and
decay of heterotrophic, fermenting, autotrophic, methanogenic, and sulfate-reducing
and sulfide-oxidizing bacteria (Figs. 7.1 and 7.2).

Hydrolysis and bacterial growth aremodeled usingmonod-type kinetics including
substrate consumption and inhibition terms as follows:
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Table 7.1 Components of the biokinetic model CWM1

Description Parameter Unit

soluble

Dissolved oxygen. So gO2

Fermentable, readily biodegradable soluble COD Sf g COD

Fermentation products as acetate Sa g COD

Inert soluble COD. Si g COD

Ammonium and ammonia nitrogen Snh g N

Nitrate nitrogen Sno g N

Sulfate sulfur Sso4 g S

Dihydrogensulfide sulfur Sh2s g S

particulate

Slowly biodegradable particulate COD. Xs g COD

Inert particulate COD. Xi g COD

Heterotrophic bacteria Xh g COD

Autotrophic nitrifying bacteria Xa g COD

Acetotrophic methanogenic bacteria Xamb g COD

Fermenting bacteria Xfb g COD

Acetotrophic sulfate reducing bacteria Xarsb g COD

Sulfide oxidizing bacteria Xsob g COD

Fig. 7.2 Reaction network of substrates and products (cycles), and bacteria (boxes) of the biokinetic
model CWM1 according to (Samso and Garcia, 2013b) CO2, CH4, and N2 are drawn here for
facilitating the conceptual understanding, however, their production is not included in the model
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Table 7.2 Required Input Files

File Description

wetland.geo GMSH geometry file

wetland.gli OGS geometry file

wetland.msh Finite element mesh

wetland.pcs Processes definition

wetland.num Numerical methods

wetland.tim Time discretization

wetland.mmp Porous medium properties

wetland.mfp Fluid properties

wetland.msp Solid material properties

wetland.mcp RT component properties

phreeqc.dat Phreeqc database

wetland.pqc Phreeqc control

wetland.rei Reaction interface definition

wetland.ic Initial conditions

wetland.st Source terms

wetland.bc Boundary conditions

wetland.out Output specification

rk,growth = μ ·
[

n∏
i=1

(
Si

KSi + Si

)] ⎡
⎣

m∏
j=1

(
K j

K j + Sj

)⎤
⎦ · Xk (7.7)

Here, μ is the maximum growth rate of bacteria Xk in h−1, Ci is the concentra-
tion of the i-th substrate species in mgL−1, KSi is the corresponding saturation or
inhibition term in mgL−1, and Xk the concentration of bacteria type k in mgL−1.

Bacterial decay is assumed to follow first-order rate equation:

rk,decay = bk · Xk (7.8)

with Xk being the k-th bacterial type in mgL−1 and the corresponding decay rate bk
in h−1 (Table7.2).
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7.4 Practical Model Setup

7.4.1 Preprocessing

7.4.1.1 Domain Geometry and Mesh

The 2D model domain is 10.3m by 0.6m and split into a 0.3m long mixing zone
at the system front and a main zone for treatment. The element size is 0.1m. To
generate a mesh withGMSH, you have to write an input file wetland.geo that defines
the domain geometry, first. Define six points, then seven lines through these points,
and create loops of these lines to define two surface structures.

Listing 7.1 GMSH geometry file wetland.geo

// set element size and points
lc=0.1;
Point (1) = {0,0,0,lc};
Point (2) = {0.3, 0, 0, lc};
Point (3) = {10.3,0,0,lc};
Point (4) = {10.3,0,0.6,lc};
Point (5) = {0.3,0,0.6,lc};
Point (6) = {0,0,0.6,lc};

// set lines
Line (7) = {1 ,2};
Line (8) = {2 ,5};
Line (9) = {5 ,6};
Line (10) = {6 ,1};
Line (11) = {2 ,3};
Line (12) = {3 ,4};
Line (13) = {4 ,5};

// combine lines to loops for subsequent surfaces
Line Loop (14) ={7,8 ,9,10};
Line Loop (15) ={11,12,13,-8};

// set surfaces
Plane Surface (16) ={14};
Plane Surface (17) ={15};
Physical Surface (" mixing ") ={16};
Physical Surface ("main") ={17};

This file has to be openedwithGMSH then. To create themesh click on Mesh →
2d, to save it as click on File → Save As... and save as wetlandpre.msh
(Fig. 7.3).

Now, you have to import the mesh file into the OGS EXPLORER to transform
the format in a readable form for OGS. Open the OGS EXPLORER and click on
File → Import Files → GMSH Files... to import wetlandpre.msh.
Now click on the mesh name , then on Tools → Remove Mesh Elements
→ Element Type → Line → OK to remove any line elements. Right-
click on the mesh name and on Edit material groups... → Condense
material groups to smallest possible range → OK to adjust
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Fig. 7.3 Schematic of a horizontal subsurface flow treatment wetland

that material groups will start with number zero. Now click the symbol Save
mesh... and save it as wetland.msh. The file wetland.msh should look like:

Listing 7.2 Finite element mesh file wetland.msh

#FEM_MSH // Mesh keyword
$PCS_TYPE
NO_PCS
$NODES // list of nodes
928
0 0 0 0
1 0.3 0 0
2 10.3 0 0
...
$ELEMENTS // list of elements
1636
0 0 tri 225 7 6
1 0 tri 233 225 6
2 0 tri 225 232 7
...
#STOP

Now, you have to create the OGS geometry file (wetland.gli) to define geometric
entities for setting initial and boundary conditions later on . You have to define
several points to set up the domain and an outflow point (POINT3) using #POINTS;
an inflow line using #POLYLINE. To account for the initially water saturated part
(and the unsaturated one) of the domain, you have to define two surfaces. This is done
in two steps. At first, define a loop via #POLYLINE, then define a surface from the
loop via #SURFACE. In all cases, you have to define the accuracy of the geometric
entities with respect to the mesh nodes via $EPSILON (set it to 0.001).
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Listing 7.3 OGS geometry file wetland.gli

#POINTS

0 0.00000000000000 0.00000000000000 0.00000000000000 $NAME POINT0

1 0.300000000000 0.00000000000000 0.00000000000000 $NAME POINT1

2 10.3000000000000 0.00000000000000 0.00000000000000 $NAME POINT2

3 10.3000000000000 0.00000000000000 0.05000000000000 $NAME POINT3

4 10.3000000000000 0.00000000000000 0.5000000000000 $NAME POINT4

5 10.3000000000000 0.00000000000000 0.60000000000 $NAME POINT5

6 0.3000000000000 0.00000000000000 0.600000000000 $NAME POINT6

7 0.0000000000000 0.00000000000000 0.600000000000 $NAME POINT7

8 0.0000000000000 0.00000000000000 0.5000000000000 $NAME POINT8

9 0.0000000000000 0.00000000000000 0.3000000000000 $NAME POINT9

10 0.0000000000000 0.00000000000000 0.4000000000000 $NAME POINT10

11 0.3000000000000 0.00000000000000 0.5000000000000 $NAME POINT11

#POLYLINE // define a polyline by pre -defined points

$NAME

top_inflow

$EPSILON

0.001

$POINTS

6

7

#POLYLINE // define the loop for a surface

$NAME

pSaturated

$EPSILON

0.001

$POINTS

0

2

4

8

0

#POLYLINE

$NAME

pUnsaturated

$EPSILON

0.001

$POINTS

4

5

7

8

4

#SURFACE

$NAME

sUnsaturated

$EPSILON

0.001

$POLYLINES

pUnsaturated

#SURFACE // now define the surface form the loop

$NAME

sSaturated

$EPSILON

0.001

$POLYLINES

pSaturated

#STOP
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7.4.1.2 Process Definition

All processes that will be simulated have to be listed in the filewetland.pcs. You have
to define each process and its primary variable. That means, one process for water
flow (RICHARDS_FLOW) and 19 processes for transport of solutes and particulates
(MASS_TRANSPORT): the 16 components of CWM1 (Fig. 7.1) plus a conservative
tracer, as well as, pH, and pe. It is always recommendable to include a conservative
tracer for inspecting the flow behavior. PH and pe are necessary components for the
coupling of OGS and IPhreeqc.

Listing 7.4 Process definition file wetland.pcs

#PROCESS
$PCS_TYPE
RICHARDS_FLOW
$PRIMARY_VARIABLE
PRESSURE1
$RELOAD
1 1

#PROCESS ; ConservativeTracer comp 0
$PCS_TYPE
MASS_TRANSPORT

#PROCESS ; pH comp 1
$PCS_TYPE
MASS_TRANSPORT

#PROCESS ; pe comp 2
$PCS_TYPE
MASS_TRANSPORT
...
#STOP

7.4.1.3 Time Discretization

The simulation time is set to 50 d with 2000 time steps of a constant time step size
of 36min (2160s) for flow and transport. Note that you have to enter the values in
seconds.

Listing 7.5 Time discretization file wetland.tim

#TIME_STEPPING
$PCS_TYPE
RICHARDS_FLOW
$TIME_START
0.0
$TIME_STEPS
2000 2160
$TIME_END
4320000
$TIME_UNIT
SECOND

#TIME_STEPPING
$PCS_TYPE
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MASS_TRANSPORT
$TIME_START
0.0
$TIME_STEPS
2000 2160
$TIME_END
4320000
$TIME_UNIT
SECOND

#STOP

7.4.1.4 Numerical Methods Definition

To solve the differential equation system for flowand transport, numericalmethod has
to be defined for water flow and mass transport as follows (wetland.num). For water
flow (RICHARDS_FLOW), a linear and a nonlinear solverwill have to be set; for trans-
port (MASS_TRANSPORT) a linear solver and mass lumping ($MASS_LUMPING)
are set.

Listing 7.6 Numerical methods file wetland.num

#NUMERICS
$PCS_TYPE
RICHARDS_FLOW
$LINEAR_SOLVER
; method error_tolerance max_iterations theta precond storage
2 1 1.0e-014 100 1.0 100 4
$NON_LINEAR_ITERATION
;type -- error_method -- max_iterations -- relaxation --

tolerance(s)
NEWTON ERNORM 10 0 1e-6
$ELE_GAUSS_POINTS
3

#NUMERICS
$PCS_TYPE
MASS_TRANSPORT
$LINEAR_SOLVER
; method error_tolerance max_iterations theta precond storage
2 6 1.e-014 1000 0.5 1 2
$ELE_GAUSS_POINTS
3
$ELE_MASS_LUMPING
1
$FEM_FCT
2 1

#STOP

7.4.1.5 Porous Media and Material Properties

All material input parameters have to be assigned using the different material input
files. The solidmatrix of the wetland system consists of gravel with defined hydraulic
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and material properties (Table7.3). You have to create a file to account for the solid
material (the gravelmatrix)wetland.msp and one for the fluid propertieswetland.mfp.
Hydraulic properties of the solid matrix have to be written in the file wetland.mmp.

Listing 7.7 Solid properties file wetland.msp

#SOLID_PROPERTIES // properties of the mixing zone
$DENSITY
1 1.8000e+003
#SOLID_PROPERTIES // properties of the main zone
$DENSITY
1 1.8000e+003
#STOP

Listing 7.8 Fluid properties file wetland.mfp

#FLUID_PROPERTIES
$FLUID_TYPE
LIQUID
$DENSITY
1 0.9997026e+03
$VISCOSITY
1 1e-003
#STOP

Listing 7.9 Porous medium properties file wetland.mmp

#MEDIUM_PROPERTIES // properties of the mixing zone
$GEOMETRY_DIMENSION
2
$GEOMETRY_AREA
5.3
$POROSITY
1 0.45
$PERMEABILITY_TENSOR
ISOTROPIC 4.166e-10
$PERMEABILITY_SATURATION
4 0.01 1.0 0.75
$CAPILLARY_PRESSURE
4 14.5
$MASS_DISPERSION
1 0.14 0.01
$DENSITY
1 1800.0
$TORTUOSITY
1 1.0

#MEDIUM_PROPERTIES // properties of the main zone
$GEOMETRY_DIMENSION
2
$GEOMETRY_AREA
5.3
$POROSITY
1 0.41
$PERMEABILITY_TENSOR
ISOTROPIC 8.333e-011
$PERMEABILITY_SATURATION
4 0.1 1.0 0.75
$CAPILLARY_PRESSURE
4 14.5
$MASS_DISPERSION
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Table 7.3 Porous Medium Properties

Parameter Symbol Value Unit

Porositymixingzone εmix 0.41

Porositymainzone εmain 0.45

Satresidual Sres 0.1

Satmax Smax 1

m m 0.75

alpha α 14.5

Permeability k 8.33E-11 m2

Dispersionlongi tudinal DT 0.01 m2 s−1

Dispersiontransversal DL 0.14 m2 s−1

Tortuosity τ 1

Gravel density ρgravel 1800 kgm−3

Water density ρwater 999.7026 kgm−3

Water viscosity η 1.00E-03 pas

1 0.14 0.01
$DENSITY
1 1800.0
$TORTUOSITY
1 1.0

#STOP

7.4.1.6 Mass Transport Component Definition

All components that take part in transport and reactions have to be listed in the file
wetland.mcp: 16 biokinetic components (Fig. 7.1), a conservative tracer, pH, and
pe. You have to define a component name ($NAME), define if the component can
be transported or not ($MOBILE) and set the diffusion model and coefficient. All
components, except pH, pe and bacteria, have to be defined as mobile. This tutorial
does not consider diffusion processes–you have to set $DIFFUSION to zero for all
components.

Listing 7.10 RT component properties file wetland.mcp

// conservative tracer

#COMPONENT_PROPERTIES ; comp 0

$NAME

Tracer

$MOBILE

1 ;MOBILE -Flag: 0=imMOBILEe , 1= MOBILEe/transported

$DIFFUSION

0 0.0 ; diffusion model type , diffusion constant
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// Phreeqc necessary components

#COMPONENT_PROPERTIES ; comp 1

$NAME

pH

$MOBILE

0

$DIFFUSION

0 0.0

#COMPONENT_PROPERTIES ; comp 2

$NAME

pe

$MOBILE

0

$DIFFUSION

0 0.0

// Reactive (biokinetic) components

#COMPONENT_PROPERTIES ; comp 13

$NAME

Sf

$MOBILE

1

$DIFFUSION

0 0.0

#COMPONENT_PROPERTIES ; comp 11

$NAME

Xh

$MOBILE

0

$DIFFUSION

0 0.0

...

#STOP

7.4.1.7 Biokinetic Reaction Definition

All relevant information regarding the biokinetic reaction computations have to be
written in the input file for PHREEQC wetland.pqc and the corresponding database
file phreeqc.dat. At first, the reactive model components, to say reactants, that are
listed in the file wetland.mcp have to be defined in Phreeqc. This is done by adding
the relevant information (element name, species, name, alkalinity, molar mass, rela-
tion to secondary species) to the keywords SOLUTION_MASTER_SPECIES and
SOLUTION_SPECIES in the Phreeqc database file phreeqc.dat–not into the wet-
land.pqc file. The keyword CALCULATE_VALUES contains values of rate constants,
etc., and has to be added to the database phreeqc.dat as well. The temporal unit of
the reaction parameters in CWM1 is a day, as PHREEQC computation is done in
seconds, values have to be converted to second first.
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Listing 7.11 Phreeqc database file phreeqc.dat

SOLUTION_MASTER_SPECIES // define the master species

Tracer Tracer 0 1 1

Do Do 0 1 1

Sf Sf 0 1 1

Sa Sa 0 1 1

...

SOLUTION_SPECIES // define the secondary species

Tracer = Tracer

log_k 0

Do = Do

log_k 0

Sf = Sf

log_k 0

...

CALCULATE_VALUES // define additional reaction parameters

Kh // Hydrolysis rate constant Kh

-start

1 value = 3 // value in 1/d

2 value = value /(24*3600 // convert to 1/s

3 SAVE value

-end

...

END

The input file wetland.pqc itself should only contain the keywords: SOLUTION
which lists the reaction component that take part, KINETICS and RATES which
define the reaction network and rates; PRINT and SELECTED_OUTPUT which
define output formats and PUNCH which includes the output of all reaction com-
ponents. It is quite important to note that a) the model equations in CWM1 are
based on concentration (g L−1), contrarily, computations in Phreeqc are based on
molality (mol kg−1). The molar mass of all components is, therefore, set to 1.0 as a
work-around.

Listing 7.12 Phreeqc control file wetland.pqc

SOLUTION 1 // definition of the reactive components taking

part in Phreeqc computations

units mol/kgw // units , temp , density , pH and pe

temp 20.000000

density 1

pH 7.0000 charge # comp 1

pe 4.0 # comp 2

Do 9.0e-3 # comp 3

Sf 0.5e-3 # comp 4

Sa 1.03-3 # comp 5

Sin 0.5e-3 # comp 6

Snh 0.5e-3 # comp 7

Sno 40.0e-3 # comp 8

Sulfide 10.00e-3 # comp 9

Sso 10.0e-3 # comp 10

Xs 0.5e-3 # comp 11

Xi 0.1e-3 # comp 12

Xh 1.36e-4 # comp 13

Xa 1.36e-4 # comp 14

Xfb 1.36e-4 # comp 15

Xamb 1.36e-4 # comp 16

Xasrb 1.36e-4 # comp 17
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Xsob 1.36e-4 # comp 18

-water 1 # kg

#ende

KINETICS

#

Aerobic_Growth_Xh_on_Sf // define a kinetic reactant

-formula Do -0.587301587301587 Sf -1.58730158730159 Snh -0.022380952

Xh 1 # Do: 1-1/Y_h Sf: -1/Y_h Snh: v_5 ,2 Xh 1

-m0 1

-tol 1e-08

#ende

RATES // define reaction rates of a kinetic reactant

#

Aerobic_Growth_Xh_on_Sf

-start

# get molalities and convert to concentration in g/l

10 Sf = MOL("Sf")

20 So2 = MOL("Do")

30 Sa = MOL("Sa")

40 Snh = MOL("Snh")

70 Sh2S = MOL(" Sulfide")

90 Xh = MOL("Xh")

# compute reaction term for specific component

110 r_Sf = Sf/( CALC_VALUE ("Ksf")+ Sf)

120 r_So2 = So2/( CALC_VALUE ("Koh")+ So2)

130 r_Sa = Sf/(Sf + Sa)

140 r_Snh = Snh /( CALC_VALUE ("Knhh")+ Snh)

170 r_Sh2s = CALC_VALUE (" Kh2s_h ") / (CALC_VALUE (" Kh2s_h ") + Sh2S )

# compute rate

200 rates = CALC_VALUE ("muh") * r_Sf * r_So2 * r_Sa * r_Snh * r_Sh2s *

Xh

# compute mass change per time step

300 dGrowth= rates*time

310 dGrowth = dGrowth

400 SAVE dGrowth

-end

#ende

PRINT

-reset true

-selected_output true

#ende

SELECTED_OUTPUT

-file phout_sel.dat

-high_precision

-reset false

#ende

USER_PUNCH // insert all reactive components

20 PUNCH TOT("Do"), TOT("Sf"), TOT("Sa"), TOT("Sin"), TOT("Snh"), TOT("

Sno

"), TOT(" Sulfide"), TOT("Sso"), TOT("Xs"), TOT("Xi"), TOT("Xh"),

TOT

("Xa"), TOT("Xfb"), TOT("Xamb"), TOT("Xasrb"), TOT("Xsob")

#ende

END

#STOP
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You also have to define additional key parameters for the interphase of OGS
toPHREEQC in the file wetland.rei. You have to define the unit of molality (moles
per weight, $MOL_PER), a constant water concentration, as well as, the pressure and
temperature to 1bar and 293.15K.

Listing 7.13 Reaction interface file wetland.rei

#REACTION_INTERFACE
$MOL_PER // set molality mol/kg
WEIGHT ; VOLUME
$WATER_CONCENTRATION
CONSTANT ; VARIABLE
$PRESSURE
CONSTANT 1.0 ; bar
$TEMPERATURE
CONSTANT 293.15 ; Kelvin

#STOP

7.4.1.8 Initial Conditions

It is assumed that an initial water table 0.5m exists (saturation of 0.5m). This results
in a linear pressure distribution from the top to the bottom of the saturated layer
(sSaturated, define in wetland.gli) and has to be considered as initial conditions for
the water pressure. Initial concentrations for the nonreactive tracer is set to zero in
the DOMAIN. Initial concentrations of Sf, Sa, Sin, Snh, Sso, Xs, and Xi are similar
to the boundary conditions (Table7.4) while all other reactive components, except
pH (set to 7.0) and pe (4.0), are set to 0.1mgL−1.

Listing 7.14 Initial conditions file wetland.ic

#INITIAL_CONDITION
$PCS_TYPE
RICHARDS_FLOW
$PRIMARY_VARIABLE
PRESSURE1
$GEO_TYPE
SURFACE sSaturated
$DIS_TYPE
GRADIENT 1 0 4905

#INITIAL_CONDITION
$PCS_TYPE
RICHARDS_FLOW
$PRIMARY_VARIABLE
PRESSURE1
$GEO_TYPE
SURFACE sUnsaturated
$DIS_TYPE
CONSTANT 0.0

#INITIAL_CONDITION
$PCS_TYPE
MASS_TRANSPORT
$PRIMARY_VARIABLE
Tracer
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$GEO_TYPE
DOMAIN
$DIS_TYPE
CONSTANT 0.0

#INITIAL_CONDITION
$PCS_TYPE
MASS_TRANSPORT
$PRIMARY_VARIABLE
Do
$GEO_TYPE
DOMAIN
$DIS_TYPE
CONSTANT 0.86e-3

...
#STOP

7.4.1.9 Boundary Conditions and Source Terms

Boundary conditions and source terms have to be added for individual processes,
by specifying the process type ($PCS_TYPE) and its primary variable ($PRIMARY
_VARIABLE). At the inflow (POLYLINE top_inflow), there is one Dirichlet
boundary condition for water pressure (0.0Pa), as well as, a Dirichlet condition for
each solute reactant, as well as, slowly biodegradable COD (Xs) and inert particulate
COD (Xi) (Table7.4). Another Dirichlet condition fixes the pressure of water flow
in the middle of the outflow (POINT3) at a head of 0.45m (4415Pa). The loading
rate of the wetland is 36.0mmd−1, this translates into a source term of 7.5819m2s−1

Table 7.4 Model Boundary Conditions

Parameter Symbol Value Unit

Influent load q 36.0 mmd−1

Conservative tracer Tracer 2.0 g L−1

Dissolved oxygen Do 0.86e-03 g L−1

Readily biodegradable
organic matter

Sf 170.0e-03 g L−1

Organic matter as
Acetate

Sa 27.0e-03 g L−1

Inert soluble organic
matter

Sin 31.0e-03 g L−1

Ammonia nitrogen Snh 57.0e-03 g L−1

Sulfate sulfur Sso 34e.0-03 g L−1

Slowly biodegradable
particulate Carbon

Xs 33.0e-03 g L−1

Inert particulate
organic matter

Xi 13.0e-03 g L−1
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along the inflow (POLYLINE top_inflow) defined in the file wetland.st. The
width of the inflow is automatically taken into consideration with the defined width
under $GEOMETRY_AREA in the file wetland.mmp.

Listing 7.15 Boundary conditions file wetland.bc

// BC water flow

#BOUNDARY_CONDITION
$PCS_TYPE
RICHARDS_FLOW
$PRIMARY_VARIABLE
PRESSURE1
$GEO_TYPE
POINT POINT3
$DIS_TYPE
CONSTANT 4415

#BOUNDARY_CONDITION
$PCS_TYPE
RICHARDS_FLOW
$PRIMARY_VARIABLE
PRESSURE1
$GEO_TYPE
POLYLINE top_inflow
$DIS_TYPE
CONSTANT 0

// BC Mass Transport

#BOUNDARY_CONDITION
$PCS_TYPE
MASS_TRANSPORT
$PRIMARY_VARIABLE
Do
$GEO_TYPE
POLYLINE top_inflow
$DIS_TYPE
CONSTANT 0.86e-3

...
#STOP

Listing 7.16 Source term file wetland.st

#SOURCE_TERM
$PCS_TYPE
RICHARDS_FLOW
$PRIMARY_VARIABLE
PRESSURE1
$GEO_TYPE
POLYLINE top_inflow
$DIS_TYPE
CONSTANT_NEUMANN 7.75819 -05

#STOP

The component tracer is added as an impulse at simulation start. Therefore, the
boundary condition of this component is time dependent. You will have to define
a boundary condition in the file wetland.bc with the sub-keyword $TIME_TYPE
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and an additional file wetland.rfd which contains information about the boundary
condition values at individual time steps. Simply, the value inwetland.bc ismultiplied
by the values of the referred curve in wetland.rfd. Here, 98g of tracer will be added
at simulation start. That means 2 g L−1 of tracer will have to be added in the first
time step (0–2160s).

Listing 7.17 Boundary condition for the tracer in wetland.bc

#BOUNDARY_CONDITION
$PCS_TYPE
MASS_TRANSPORT
$PRIMARY_VARIABLE
Tracer
$GEO_TYPE
POLYLINE top_inflow
$DIS_TYPE
CONSTANT 2.0
$TIM_TYPE // activates time dependent bc
CURVE 1 // use values of curve 1 from *.rfd file

#STOP

Listing 7.18 Time series of the tracer boundary condition wetland.rfd

#CURVES
0 1 // bc at time 0 sec is one
2160 1 // bc at time 2160 sec is one
4320 0 // bc at time 4320 sec is zero
43200000 0 // bc at time 43200000 sec is still zero

#STOP

7.4.1.10 Output Format Definition

Finally, the output data for subsequent visualization has to be defined in the file
wetland.out. Values of the pressure, water velocity, and all reactive components
at every mesh node of the domain at every time step have to be exported. You
have to define an output block for each process (here: either RICHARDS_FLOW or
MASS_TRANSPORT); listing each variable under $NOD_VALUES to export its nodal
values; defining the geometric entity the nodes belong to ($GEO_TYPE) and defining
the time steps increment at which output values should be written ($TIME_TYPE)

Listing 7.19 Output file wetland.out

#OUTPUT
$PCS_TYPE
RICHARDS_FLOW
$NOD_VALUES
PRESSURE1
SATURATION1
VELOCITY_X1
VELOCITY_Y1
VELOCITY_Z1
$GEO_TYPE
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DOMAIN
$DAT_TYPE
PVD
$TIM_TYPE
STEPS 1

#OUTPUT
$PCS_TYPE
MASS_TRANSPORT
$NOD_VALUES
Tracer
Do
Sf
Sa
Sin
Snh
Sno
Sulfide
Sso
Xs
Xi
Xh
Xa
Xfb
Xamb
Xasrb
Xsob
$GEO_TYPE
DOMAIN
$DAT_TYPE
PVD
$TIM_TYPE
STEPS 1

#STOP

7.4.2 Model Execution

You have to put all input files into one directory. It is mandatory to name the files
all the same, otherwise, the simulation will not start as files with other names than
the specified will not be considered for program execution. Use the name wetland.
Additionally, theOGS executable ogs.exe has to be added. At the time of this writing,
it is recommended to use theOGS version 5.5. It is recommended to run a simulation
project as this one in several steps with increasing complexity. At first, to establish a
steady-statewater flowfield run themodel for a few time stepswith a smaller time step
size and without MASS_TRANSPORT processes. To exclude MASS_TRANSPORT
processes, simply leave all the MASS_TRANSPORT blocs out of the process filewet-
land.pcs, time step filewetland.tim and numeric filewetland.num; remove all IC, BC
and output values related to mass transport; remove the files wetland.mcp and wet-
land.pqc. Then, change the number of time steps and the size for RICHARDS_FLOW
under the keyword $TIME_STEPS in the file wetland.tim to ten and 360, then save
the file. Now just click on the ogs.exe, the command line should open, type wetland
and pressENTER (Fig. 7.4).OGSwill run and subsequently create output files. Check



84 E. Jang et al.

Fig. 7.4 Title view of ogs.exe, enter wetland and press ENTER

Fig. 7.5 Visualization of water flow in ParaView

the development of a steady-state flow field by executing the steps in the subsequent
chapter (compare your results with Fig. 7.8).

If the model runs into steady state, you can retype the time stepping to the prior
defined conditions (TIME_STEPS 100 and 4320) and change the values of the key-
word $RELOAD under RICHARDS_FLOW in the process file wetland.pcs to two.
This tells OGS to use the results of the last time step of the previous simulation
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Fig. 7.6 Visualization of substrate and bacteria distribution in ParaView

Fig. 7.7 Plot times series of individual nodes in ParaView

computed as starting conditions, to say, OGS now bypasses computing initial condi-
tions. Now include the MASS_TRANSPORT processes again. The second run should
include transport of all components but still exclude biokinetic reactions to verify the
transport model. To achieve this, simply leave the Phreeqc input file wetland.pqc out
of the model folder. If you now click on the ogs.exe, type wetland and press ENTER,
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Fig. 7.8 Pressure distribution and streamlines in ParaView

the transport model will be started. The time series of the tracer at a point close to
the outlet should be similar as in Fig. 7.11. All other components should exhibit a
horizontal line. Finally, copy the wetland.pqc file back into the model project folder
and execute the model again. Now, biokinetic reactions will be included. You will
notice this in the output of ogs.exe...and in the computation time as well, ;-).

Listing 7.20 Change $TIME_STEPS to 10 and the step size to 360 to compute steady-state flow
wetland.tim

#TIME_STEPPING
$PCS_TYPE
RICHARDS_FLOW
$TIME_START
0.0
$TIME_STEPS
10 360

...

#STOP

Listing 7.21 Change $RELOAD to 2 after computing steady-state water flow wetland.pcs

#PROCESS
$PCS_TYPE
RICHARDS_FLOW
$PRIMARY_VARIABLE
PRESSURE1
$RELOAD
2

...
#STOP
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7.4.3 Post-processing

If the simulation is finished, open the program ParaView. Click on File →
Open choose the directory and click on the file wetland_RICHARDS_FLOW.pvd
(Fig. 7.5).Now, thefilename should appear under builtin: in the pipeline browser.
Click on Set view direction to +Y in the toolbar menu to set the right
perspective. Then click on wetland_RICHARDS_FLOW.pvd in the pipeline
browser and on Stream Tracer in the toolbar menu. Scroll down to Seeds
in the Properties field and set Seed Type → High Resolution Line
Source, set Resolution → 10 and uncheck the tickmark Show Line, click
on Apply. Now click on Play in the toolbar menu. You should see the simulation
progress in the model domain, with developing distribution of PRESSURE1 and a
streamline field. The streamlines should look like in Fig. 7.8.

To visualize the distribution of substrate components and bacteria types, again,
click on File → Open choose the directory and click on the file wetland_MASS
_TRANSPORT.pvd (Fig. 7.6). Now, click on wetland_MASS_ TRANSPORT.pvd in
the pipeline browser and choose the coloring of interest in the Properties field.
With Coloring, you can select the MASS_TRANSPORT component to visualize.
For screenshots click on File → Save screenshot.

If you want to plot concentration time series of certain components, such as the
tracer, click on Interactive Select Points On in the taskbar at the top
of the layout window (Fig. 7.7). Now, select the first node above the corner at the
bottom right, then click on Plot Selection Over Time and unmark the tick
at Report Selection Statistics Only in the Properties field and
click on Apply. A new view showing the times series of all components will show
up. Simply scroll down the Properties field and select or unselect your desired
components (Fig. 7.8).

7.5 Simulation Results

The tutorial simulation consists of the fate of a conservative tracer, as well as, several
bacteria and substrate types in a passive horizontal subsurface flow treatment wet-
land over 50d. At the end of the simulation, different patterns of bacterial groups and
substrate components develop within the simulated system (Figs. 7.9 and 7.10). The
tracer time series shows a breakthrough curve typically observed in subsurface flow
treatment wetlands and can be interpreted as a verification of the transport model
due to the absence of any visible oscillations (Fig. 7.9). Temporal development of the
effluent concentrations show an initial transition into a rather steady state in the first
10d (Fig. 7.11). The reason is that the wetland domain was filled with wastewater
similar to the influent at simulation start-up. The initial Do, Sf, and Xs in the domain
were then rapidly consumed by heterotrophic and fermenting bacteria resulting in
a decrease of these substances and an increase of Sa in the effluent. After 50d of
simulation bacteria mainly developed at the inflow region (Fig. 7.10), as this is the
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Fig. 7.9 Substrate component distribution across the modeled wetland domain after 50d of simu-
lation

Fig. 7.10 Bacteria distribution across the modeled wetland domain after 50d of simulation

source of new substrate. However, fermenting bacteria are dominating the popula-
tion due to their independence of oxygen and fast growth rate among the anaerobe
bacteria. Sa, as the fermentation product of Xfb, is the predominant form of COD
in the whole wetland domain and still present in high concentrations throughout the
wetland. It shows that the capacity of methanogenic bacteria (Xamb) is not enough
to mineralize all available Sa. This is probably due to the low growth rate of Xamb
and the short simulation time of 50d only. Bacterial patterns would look different
if the simulation will cover a longer period. In general, the microbial character of
the simulated wetland can be described as anaerobic which is typical for passive
horizontal subsurface flow wetlands used for secondary wastewater treatment.
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Fig. 7.11 Development of the effluent quality during 50d of simulation
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Appendix A
OpenGeoSys v5 Keywords Description

This section provides a wrap-up compendium of the OGS v5 keywords used in this
tutorial. A more comprehensive compilation of the keywords with examples you can
find at www.opengeosys.org/help/documentation/ and https://svn.ufz.de/ogs/wiki/
public/doc-auto.

A.1 PCS—Process Definition

Keyword #PROCESS

Indicate the beginning of a PCS block. Each block identifies one process and
its primary variable. It endswith the beginning of a newPCS block, i.e., #PROCESS,
or with the file input terminator #STOP

Sub-keyword $PCS_TYPE

Define the definition of the process. Only one parameter can be defined per PCS
block

Parameter char

The parameter is defined one line below the $PCS_TYPE. The keywords and accord-
ing primary variables are listed as below

GROUNDWATER_FLOW HEAD

LIQUID_FLOW PRESSURE1

RICHARDS_FLOW PRESSURE1

AIR_FLOW PRESSURE1, TEMPERATURE1

MULTI_PHASE_FLOW PRESSURE1, PRESSURE2

PS_GLOBAL PRESSURE1, SATURATION2

HEAT_TRANSPORT TEMPERATURE1

DEFORMATION DISPLACEMENT_X1, DISPLACEMENT_Y1, DISPLACEMENT_Z1

MASS_TRANSPORT Solute species which defined in the component property file (*.mcp)

OVERLAND_FLOW HEAD

FLUID_MOMENTUM VELOCITY1_X, VELOCITY1_Y, VELOCITY1_Z

RANDOM_WALK with particles in *.pct file

© The Author(s) 2018
E. Jang et al., OpenGeoSys Tutorial, SpringerBriefs in Earth System Sciences,
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Listing A.1 PCS keyword

#PROCESS // process keyword
$PCS_TYPE // process type sub -keyword
GROUNDWATER_FLOW // specified process

#PROCESS
$PCS_TYPE // process type sub -keyword
MASS_TRANSPORT // specified process
#STOP // end of input data

A.2 GLI—Geometry Condition

Keyword #POINTS

A list of points including the point number and the Cartesian coordinates is defined under #POINT.
Optionally, a point name can be assigned to each point with the sub-keyword $NAME

Parameters int double double double

The first parameter defines the point number, and the following three values are the Cartesian coordinates
X Y Z.

Sub-keyword $NAME

Define a name of points. Note that this sub-keyword is only required if the specific points is used for
boundary and initial conditions, source terms, and output.

Parameters char

Names can be written after the coordinate definition with the sub-keyword $NAME

Keyword #POLYLINE

Define a topological description of a polyline or polygon. Each polyline definition includes a name and a
list of point’s number. Polygons are defined in the same way as polylines, with the only difference that the
fist and last point are identical.

Sub-keyword $NAME

Defines a name of polyline.

Parameters char

The names are written in the subsequent line under $NAME.

Sub-keyword $POINTS

The order of points defines the topology, i.e., the point-to-point connection.

Parameter Points of polylines

Keyword #SURFACE

Surfaces are built from polylines specified in sub-keyword $POLYLINE.

Sub-keyword $NAME

Defines a name of surface.

Parameter char

The names are written in the subsequent line under $NAME.

Sub-keyword $POLYLINE

Surfaces should be completely closed by the set of polylines.

Parameter char

The name of the polyline is written in the subsequent line under $POLYLINE.
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Listing A.2 GLI keyword

#POINTS // points keyword

0 0 0 0 $NAME POINT0 // point number | x | y | z | point name

1 1 0 0 $NAME POINT1

2 1 1 0 $NAME POINT2

[...]

#POLYLINE // polyline keyword

$NAME // polyline name sub -keyword

TOP // polyline name

$POINTS // polyline points sub -keyword

0 // point of polyline

1 // dito

[...]

#POLYLINE // polyline keyword

$NAME // polyline name sub -keyword

BOUNDARY // polyline name

$POINTS // polyline points sub -keyword

0 // point ofpolyline

1 // dito

2 // dito

0 // dito; polygon , first and last point are

identical

#SURFAE // surface keyword

$NAME // surface name sub -keyword

catchment // name of surface

$POLYLINES // surface polyline sub -keyword

BOUNDARY // polyline of surface

#STOP // end of input data

A.3 MSH—Finite Element Mesh

Keyword #FEM_MSH

The header of the mesh file.

Sub-keywords $NODES

Define the definition of all node number and coordinates (X Y Z).

Parameter int double double double

The first parameter (int) defines the node index. The numbering starts always
with “0” and must be completed and without gaps. The following three
values (double double double) are the Cartesian coordinates.

Sub-keyword $ELEMENTS

Introduces the topological definition of element types and their connectivity

Parameter int int char int int int int int int int int

The first parameter (int) defines the element index. The numbering starts always
with “0” and must be complete and without gaps. The second parameter (int)
assigns a material number to the element. Therefore, the element is directly
linked with the material properties given in the material medium property file
(*.mmp). Again, we start counting from zero, i.e., “0” is linked with the first
material property definition of the MMP file. The third parameter (char) defines
the element type. OGS supports the following element type keywords: line (line)
tri (triangle) quad (rectangle) tet (tetrahedra) pris (prism) hex (hexahedra).
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Listing A.3 MSH keyword

#FEM_MSH // file/object keyword

$NODES // node sub -keyword

61 // number of grid nodes

0 0 0 0 // node number x y z

1 0 0 1 // dito

[...]

59 0 0 59

60 0 0 60

$ELEMENTS // element sub -keyword

60 // number of elements

0 0 line 0 1 // element number|material group|type|element node numbers

1 0 line 1 2 // dito

[...]

59 0 line 59 60 // dito

#STOP // end of input data

A.4 NUM—Numerical Properties

Keyword #NUMERICS

Define the beginning of process-related numerical settings. It ends with the beginning of a new NUM
block, i.e., #NUMERICS, or with the file input terminator #STOP.

Sub-keyword $PCS_TYPE

Defines specification of the process.

Parameter Only one parameter can be defined here. The possible parameters are the OGS process type keywords (see
process types listed at the PCS Sect.A.1). In Listing A.1, only groundwater flow is considered.

Sub-keyword $LINEAR_SOLVER

Set up a numerical solver for linear problems.

Parameters int int double int double int int

The first parameter int specifies the types of the linear solver, i.e., the solver method that will be used to solve
the above-defined processes. Linear type is given in Table A.1

The second parameter int enables to define a criterion for convergence

1. Absolutely error ||r || < ε

2. ||r || < ε||b||
3. ||rn|| < ε||rn − 1||
4. if ||rn|| < 1 then ||rn|| < ε||rn − 1|| else ||r || < ε

5. ||rn|| < ε||x ||
6. ||rn|| < ε max ||rn − 1||, ||x ||, ||b||
The third parameter enables to define an error tolerance ε

The fourth parameter is the maximal number of linear solver iterations one time step

The fifth parameter is theta, a relaxation number for the Laplacian in the range
of θ ∈ [0, 1]
The sixth parameter allows setup preconditioning. The available preconditioners are:
0 No preconditioner,
1 Jacobi preconditioner,
100 ILU preconditioner.

The seventh parameter defines the storage model as:
2 unsymmetrical matrix,
4 symmetrical matrix.
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Listing A.4 NUM keyword

#NUMERICS // process keyword

$PCS_TYPE // process type sub -keyword , see PCS above

GROUNDWATER_FLOW

$LINEAR_SOLVER // linear solver type sub -keyword , see table below

2 5 1.e-014 1000 1.0 100 4 //

#STOP // end of input data

A.5 TIM—Time Discretization

Keyword #TIME_STEPPING

Define the beginning of the time stepping specifications. It ends with the beginning of a new TIM
block, i.e., #TIME_STEPPING, or with the file input terminator #STOP.

Sub-keyword $PCS_TYPE

Here, it is required to define to which simulated process the time step scheme belongs.

Parameter The possible parameters are the OGS process type keywords (see process types listed at the PCS
Sect.A.1).

Sub-keyword $TIME_STEPS

Define the number and size of time step.

Parameter The first parameter defines the number of time steps and the second values is the time step size.
Listing A.5 shows the definition of 1000 time steps, each with a length of 1 day.

Sub-keyword $TIME_STARTS

Set the beginning of the simulation time.

Parameter The parameter must be written in the subsequent line after the keyword. In Listing A.5, simulation
starts at the time 0.0

Sub-keyword $TIME_END

Define when simulation ends. The simulations stops at this specific time only if enough time steps
have been defined by $TIME_STEPS, otherwise it ends with the last defined time step.

Parameter The parameter is defined after the keyword. In Listing A.5, the simulation ends after 1000 days.

Sub-keyword $TIME_UNIT

Define the time unit. The default setting is SECOND.

Parameter The possible time unit is SECOND, MINUTE, HOUR, DAY, MONTH, or YEAR. In Listing A.5, the
time unit is day.

Listing A.5 TIM keyword

#TIME_STEPPING // timt stepping keyword
$PCS_TYPE // process sub -keyword
GROUNDWATER_FLOW // specified process
$TIME_STEPS // time steps sub -keyword
1000 1 // number of times steps | times step length
$TIME_START // starting time sub -keyword
0.0 // starting time value
$TIME_END // end time sub -keyword
1000 // end time value
$TIME_UNIT // specified time unit
DAY // SECOND , DAY , YEAR
#STOP // end of input data
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Table A.1 Linear solver 1st parameter Solver

1 SpGAUSS, direct solver

2 SpBICGSTAB

3 SpBICG

4 SpQMRCGSTAB

5 SpCG

6 SpCGNR

7 CGS

8 SpRichard

9 SpJOR

10 SpSOR

A.6 IC—Initial Condition

Keyword #INITIAL_CONDITION

Each component needs one block. It ends with the beginning of a new IC block or
with the file input terminator #STOP.

Sub-keywords $PCS_TYPE

Define the process

Parameter The possible processes are listed in Sect.A.1

Sub-keyword $PRIMARY_VARIABLE

Define the primary variable

Parameter The available primary variables are listed in Sect.A.1

Sub-keyword $GEO_TYPE

Define the geometric entity of the source term

Parameter Type (POINT, POLYLINE, SURFACE, DOMAIN) and name such as POINT1

Sub-keyword $DIS_TYPE

Define how data are distributed over the defined geometric object, e.g., domain or
surface, i.e., a certain defined value or the average of the value can be assigned to
each node. There are several types (CONSTANT, GRADIENT)

Parameter chr double

CONSTANT defines a constant value

GRADIENT defines a gradient by entering a relationship, a start, and an end value.
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Listing A.6 IC keyword

#INITIAL_CONDITION

$PCS_TYPE // process type sub -keyword

RICHARDS_FLOW // specified process

$PRIMARY_VARIABLE // primary variable sub -keyword

PRESSURE1 // specified primary variable

$GEO_TYPE // geometry type sub -keyword

DOMAIN // specified geometry type | geometry name

$DIS_TYPE // initial condition type sub -keyword

GRADIENT 1 0 9810 // initial condition type | model (linear) | start value | end

value

#INITIAL_CONDITION

$PCS_TYPE

MASS_TRANSPORT

$PRIMARY_VARIABLE

Tracer // specified primary variable

$GEO_TYPE // geometry type sub -keyword

DOMAIN // specified geometry type | geometry name

$DIS_TYPE // initial condition type sub -keyword

CONSTANT 0 // initial condition type | value

[...]

#STOP

A.7 BC—Boundary Condition

Keyword #BOUNDARY_CONDITION

Define the beginning of a BC file description. It ends with the beginning of a new BC block or with the
file input terminator #STOP.

Sub-keyword $PCS_TYPE

Define the process for which to add a source term

Parameter see PCS

Sub-keyword $PRIMARY_VARIABLE

Define the primary variable for which to add a source term

Parameters see PCS

Sub-keyword $GEO_TYPE

Define the geometric entity of the source term

Parameter chr chr

Type (POINT, POLYLINE, SURFACE, DOMAIN) and name such as POINT1

Sub-keyword $DIS_TYPE

Define how the bc is distributed over the defined geometric object

see IC

Sub-keyword $TIM_TYPE

Define a time-dependent boundary condition, such as a tracer injection at time X.

Parameter chr int

CURVE and a number indicating the time function defined in the file *.rfd. The value of the bc will be
multiplied with the value defined in the *.rfd file at the specified time steps.
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Note that CONSTANT_NEUMANN cannot be used for boundary conditions.

Listing A.7 BC keyword

#BOUNDARY_CONDITION
$PCS_TYPE // process type sub -keyword
GROUNDWATER_FLOW // specified process
$PRIMARY_VARIABLE // primary variable sub -keyword
HEAD // specified primary variable
$GEO_TYPE // geometry type sub -keyword
POLYLINE RIGHT // specified geometry type | geometry

name
$DIS_TYPE // boundary condition type sub -keyword
CONSTANT 10.5 // boundary condition type | value

#BOUNDARY_CONDITION
$PCS_TYPE // process type sub -keyword
MASS_TRANSPORT
$PRIMARY_VARIABLE
Tracer
$GEO_TYPE // geometry type sub -keyword
POLYLINE TOP // specified geometry type | geometry

name
$DIS_TYPE // boundary condition type sub -keyword
CONSTANT 1.5e-2 // boundary condition type | value
$TIM_TYPE // sub -keyword for time dependent bc
CURVE 1 // define the time function to use
[...]

#STOP

A.8 ST—Source/Sink Terms

Keyword #SOURCE_TERM

Start new source term block. It ends with the beginning of a new ST block or with the file
input terminator #STOP.

Sub-keywords $PCS_TYPE

Define the process for which to add a source term

Parameter see PCS

Sub-keyword $PRIMARY_VARIABLE

Define the primary variable for which to add a source term

Parameter see PCS

Sub-keyword $GEO_TYPE

Define the geometric entity of the source term

Parameter see IC

Sub-keyword $DIS_TYPE

Define how the source term values will be distributed on the defined geometric entity

Parameter see IC
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Listing A.8 ST keyword

#SOURCE_TERM // source term keyword
$PCS_TYPE // process type sub -keyword
RICHARDS_FLOW // specified process
$PRIMARY_VARIABLE // primary variable sub -keyword
PRESSURE1 // specified primary variable
$GEO_TYPE // geometry type sub -keyword
POINT POINT0 // specified geometry type | geometry

name
$DIS_TYPE // boundary condition type sub -keyword
CONSTANT 1E-6 // source term type | value
#STOP // end of input data

A.9 MCP—Component Properties

Listing A.9 MCP keyword

#COMPONENT_PROPERTIES

$NAME

N(5)

$MOBILE // 1= MOBILE/transported

1

$DIFFUSION

1 0.3e-9 // constant diffusion ceofficient , set to 0.3e-9

#COMPONENT_PROPERTIES

$NAME

Pyrite ;

$MOBILE

0 // 0= imMOBILEe

$DIFFUSION

0 // diffusion model type , diffusion constant

#COMPONENT_PROPERTIES

[..]

#STOP

A.10 MFP—Fluid Properties

Listing A.10 MFP keyword

#FLUID_PROPERTIES
$FLUID_TYPE // sub -keyword to set the fluid type
LIQUID // liquid fluid selected
$DENSITY // desnsity sub -keyword
1 0.9997026e+03 // density model 1 (constant) chosen ,

// density set to 0.9997026e+03 kg /m3
$VISCOSITY // viscosity sub -keyword
1 1.308e-003 // viscosity model 1 (constant) chosen ,

// viscosity set to 1.308e-003 kg /m /s
#STOP
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Keyword #COMPONENT_PROPERTIES

Start a new component bloc, every component must have one bloc. It ends with the beginning of a new
MCP block or with the file input terminator #STOP.

Sub-keyword $NAME

Set the component name

Parameter chr

Sub-keyword $MOBILE

Define whether the component is mobile or immobile

Parameter int

0 = immobile, 1 = mobile

Sub-keyword $DIFFUSION

Define the diffusion model type and value

Parameter int double

−1 No diffusion specified
0 User-defined function
1 Constant diffusion coefficient in m2s−1

10 Temperature-dependent laws

Keyword #FLUID_PROPERTIES

Define the beginning of a MFP file description. It contains the description of one or
more fluids.

Sub-keyword $DENSITY

Define a fluid density model

Parameters int double

The parameter (int) indicates the density model type (see a Table A.2).

The second parameter (double) gives the density value (kg · m−3)

Sub-keyword $VISCOSITY

Define a fluid viscosity model

Parameters int double

The first parameter (int) defines the viscosity model type and the second value
(double) gives the viscosity of the fluid.

Table A.2 Density models

Model Meaning Formula Parameters

0 Curve RFD file

1 Constant value ρ0 value of ρ0

2 Pressure dependent ρ(p) = ρ0(1 + βp(p − p0)) ρ0, βp, p0
3 Salinity dependent ρ(C) = ρ0(1 + βC (C − C0)) ρ0, βp,C0

4 Temperature dependent ρ(p) = ρ0(1 + βT (T − T0)) ρ0, βT , T0
. . . . . . . . . . . .
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A.11 MSP—Solid Properties

Keyword #SOLID_PROPERTIES

Indicate the start of a new bloc to define properties of the solid phase.

Sub-keyword $DENSITY

Define the density model of a solid phase.

Parameters see MFP

Listing A.11 MSP keyword

#SOLID_PROPERTIES // solid properties keyword
$DENSITY // solid density sub -keyword

1 2500 // type (1: constant value) | value
#STOP // end of input data

A.12 MMP—Porous Medium Properties

Keyword #MEDIUM_PROPERTIES

Indicate the beginning of the material property description.

Sub-keyword $GEOMETRY_DIMENSION

Define the geometric dimension of the model domain.

Sub-keyword $GEOMETRY_AREA

Define a constant thickness [m] in z-direction for a two-dimensional groundwater flow model.

Parameter double

thickness in meter(Note that it does not work for vertical models, i.e., in x- or y-directions.

Sub-keyword $POROSITY

Specify the porosity of a medium (esp., for reactive mass transport)

Parameter int double

The first parameter defines a porosity model type and the second value is the porosity of the material properties.

Sub-keyword $STORAGE

This keyword specifies the storativity of a material, i.e., the volumetric specific storage which is the volume of water that
the aquifer released from storage.

Parameter int double

The first parameter defines a storage model type (1 = constant) and the second values indicate that the storage.

Parameters

Sub-keyword $PERMEABILITY_TENSOR

Define the intrinsic permeability. Both isotropic and anisotropic are supported.

Parameters char double...

The first parameter indicateswhether ISOTROPIC,ORTHOTROPIC, orANISOTROPIC. For the isotropic cases, one perme-
ability value is used for all direction. However the orthotropic case, three values are required for the X-, Y-, and Z-direction.
The anisotropic case needs to define a 3 *3 permeability tensor. For groundwater flow processes (GROUNDWATER_FLOW),
the hydraulic conductivity (m · s−1) is used instead of the permeability.



102 Appendix A: OpenGeoSys v5 Keywords Description

Listing A.12 MMP keyword

#MEDIUM_PROPERTIES // solid properties keyword
$GEOMETRY_DIMENSION // dimension sub -keyword
1 // 1: one -dimensional problem

$GEOMETRY_AREA // geometry area sub -keyword
1.0 // value in square meter if 1D

$POROSITY // porosity sub -keyword
1 0.10 // type (1: constant value) | value

$STORAGE // storativity sub -keyword
1 0.0 // type (1: constant value) | value

$TORTUOSITY // tortuosity sub -keyword
1 1.000000e+000 // type (1: constant value) | value

$PERMEABILITY_TENSOR // permeability sub -keyword
ISOTROPIC 1.0e-15 // tensor type (ISOTROPIC) | value(s)

#STOP // end of input data

It is worth to mention that the model value is the specific storage divided by fluid
density and gravity acceleration constant in Pa−1 for the liquid flow processes.

A.13 OUT—Output Parameters

Keyword #OUTPUT

Indicate the beginning of an output block which defines the data that will be exported during the simulation run.
One output blocks ends with the beginning of the following output blocks, i.e., #OUTPUT, or with the file input
terminator #STOP.

Sub-keyword $PCS_TYPE

Description Specify the process

Parameters The parameter is one line below the keyword.

see PCS

Sub-keyword $NOD_VALUES

Define what node related values will be written as output.

Parameter chr

The parameter depends on the processes.

see $ELE_VALUES

Sub-keyword $GEO_TYPE

Define the geometric entity of which data will be exported such as the whole DOMAIN or a POINT.

Parameter chr chr

The first parameter indicates the geometric object and the second parameter is the name of the object as defined in the
corresponding GLI file.

see IC

Sub-keywords $DAT_TYPE

Assign the ASCII data format of the output files as either Tecplot or VTK.

Parameter chr

VTK or TECPLOT.

Sub-keyword $TIM_TYPE

Define at which time step increments output values will be written.

Parameter int

The parameters can be specified in the next line and include the STEPS. STEPS indicates the input of the output
increment frequency given by the following integral number n > 0. The output will be written every n th time step.
This number defines if every time), or every 101st time steps (STEPS 101) .. is written
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Listing A.13 OUT keyword

#OUTPUT // output keyword
$PCS_TYPE // process sub -keyword
RICHARDS_FLOW // specified process

$NOD_VALUES // nodal values sub -keyword
PRESSURE1 // specified nodal values

$GEO_TYPE // geometry type sub -keyword
POLYLINE bottom // geometry type and name

$DAT_TYPE // specified output format
VTK // VTK specified

$TIM_TYPE // output times sub -keyword
STEPS 1 // output at every time step

#STOP // end of input data
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